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1 Introduction

About this chapter
This chapter contains important user information, descriptions of safety notices,
intended use of the Biacore™ S200 system, and lists of associated documentation.

In this chapter

Section See page

1.1 About this manual 5

1.2 Important user information 6

1.3 Associated documentation 8

1 Introduction
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1.1 About this manual

Purpose of this manual
The Operating Instructions provide you with the information needed to install, operate
and maintain the product in a safe way.

Typographical conventions
Software items are identified in the text by bold italic text.

Hardware items are identified in the text by bold text.

In electronic format, references in italics are clickable hyperlinks.

1 Introduction
1.1 About this manual
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1.2 Important user information

Read this before operating the
product

All users must read the entire Operating Instructions before installing, oper-
ating or maintaining the product.

Always keep the Operating Instructions at hand when operating the product.

Do not operate the product in any other way than described in the user documenta-
tion. If you do, you may be exposed to hazards that can lead to personal injury and you
may cause damage to the equipment.

Intended use of the product
Biacore S200 is a system for real-time label-free analysis of molecular interactions in
laboratory research. Biacore S200 is intended for research use only and shall not be
used for diagnostic purposes in any clinical or in vitro procedures.

Prerequisites
In order to operate Biacore S200 in the way it is intended:

• The user must read and understand the Safety instructions chapter in the Operating
Instructions.

• The system must be installed according to the instructions in the Installation
chapter of the Operating Instructions.

• The user must have a general understanding of the use of a personal computer
running Microsoft ® Windows ® in the version provided with your product.

• The user must be acquainted with the use of general laboratory equipment and with
handling of biological materials.

Safety notices
This user documentation contains safety notices (WARNING, CAUTION, and NOTICE)
concerning the safe use of the product. See definitions below.

WARNING

WARNING indicates a hazardous situation which, if not avoided,
could result in death or serious injury. It is important not to proceed
until all stated conditions are met and clearly understood.

1 Introduction
1.2 Important user information
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CAUTION

CAUTION indicates a hazardous situation which, if not avoided,
could result in minor or moderate injury. It is important not to
proceed until all stated conditions are met and clearly understood.

NOTICE

NOTICE indicates instructions that must be followed to avoid
damage to the product or other equipment.

Notes and tips
Note: A note is used to indicate information that is important for trouble-free and

optimal use of the product.

Tip: A tip contains useful information that can improve or optimize your proce-
dures.

1 Introduction
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1.3 Associated documentation

Introduction
This section describes the user documentation that is delivered with the product, and
how to find related literature that can be downloaded or ordered from Cytiva.

User documentation
Operation of the Control and Evaluation Software is described in the Biacore S200 Soft-
ware Handbook.

Sensor surface preparation and general methodology for Biacore applications are
described in the Biacore Sensor Surface Handbook and the Biacore Assay Handbook
respectively. Methodology for concentration measurement using Biacore systems is
described in the Biacore Concentration Analysis Handbook.

Data files, application notes and user
documentation on the web

To order or download data files, application notes or user documentation, see the
instruction below.

Step Action

1 Go to cytiva.com/biacore.

2 Click Biacore S200.

3 Click RELATED DOCUMENTS.

4 Select to download the chosen literature.

1 Introduction
1.3 Associated documentation
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2 Safety instructions

About this chapter
This chapter describes safety precautions, labels and symbols that are attached to the
equipment. In addition, the chapter describes emergency and recovery procedures.

Important

WARNING
Before installing, operating or maintaining the product, all
users must read and understand the entire contents of this
chapter to become aware of the hazards involved.

In this chapter

Section See page

2.1 Safety precautions 10

2.2 Labels 16

2.3 Emergency procedures 17

2 Safety instructions
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2.1 Safety precautions

Introduction
Biacore S200 is powered by mains voltage and handles materials that can be
hazardous. Before installing, operating or maintaining the system, you must be aware
of the hazards described in this manual.

Follow the instructions to avoid injury to the operator or other personnel,
damage to samples or other substances handled by the equipment, to the
product, or to other equipment in the area.

The safety precautions in this section are grouped in the following categories:

• General precautions

• Flammable liquids and explosive environment

• Personal protection

• Installing and moving

• Operation

• Maintenance

• Decommissioning

General precautions

WARNING

Only properly trained personnel may operate and maintain the
product.

WARNING
Do not operate the Biacore S200 system in any other way than
described in the user documentation.

WARNING

Do not use any accessories not supplied or recommended by
Cytiva.

WARNING

Protective ground. The product must always be connected to a
grounded power outlet.

2 Safety instructions
2.1 Safety precautions
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WARNING

Use only mains cables supplied or approved by Cytiva.

WARNING

Do not block the rear or side panels of the instrument. The power
switch must always be easy to access. The power cord must always
be easy to disconnect.

Flammable liquids and explosive
environment

WARNING
The Biacore S200 system is not intended for use in locations with
explosion risks or fire hazards.

WARNING

Liquids marked as flammable must not be used as running buffer or
pumped reagents. Any buffer or reagent containing flammable
substances must be placed in properly capped vials in the sample
rack.

WARNING

Explosion hazard. To avoid building up an explosive atmosphere
when using flammable liquids, make sure that the room ventilation
meets the local requirements.

Personal protection
 

WARNING
Always wear appropriate protective clothing and equipment during
operation and maintenance of the Biacore S200 system. Use
required safety equipment when handling hazardous substances.

2 Safety instructions
2.1 Safety precautions
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WARNING

Liquids in the buffer bottles or tubing may be toxic or flammable or
may cause chemical burns or irritation to skin and eyes. Take
appropriate precautions in the event of bottle breakage, accidental
spillage and insecure fitting of tubings to bottles.

CAUTION
Biacore S200 systems that are used with toxic or hazardous
substances shall be marked in accordance with local laws and
regulations.

CAUTION

Pinch risk. Take care that fingers are not trapped by moving parts
on the instrument.

CAUTION

Accidental breakage of glass bottles may leave sharp fragments
and splinters that can cause cuts and abrasions.

Installing and moving

CAUTION

Wear protective shoes with steel toecaps when moving the instru-
ment to protect against falling objects.

CAUTION

Heavy object. Use proper lifting equipment, or use three or more
persons when moving the instrument. All lifting and moving must
be performed in accordance with local regulations.

CAUTION

Make sure that hands or fingers are not trapped under the instru-
ment when the instrument is lifted or moved.

2 Safety instructions
2.1 Safety precautions
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Operation

WARNING

Handle bottles carefully. Accidental breakage of buffer or water
bottles may cause flooding of the bottle tray, and liquid may come
into contact with electrical circuits, causing electric shock and/or
fire hazards.

WARNING

A fume hood or similar ventilation system shall be installed when
flammable or noxious substances are used.

WARNING

Waste liquids may contain hazardous or flammable substances.
Take appropriate precautions to avoid spillage of hazardous waste.

CAUTION

Accidental breakage of buffer or water bottles may cause flooding
of the bottle tray, and liquid may enter the instrument enclosure. If
this happens, disconnect the instrument from the mains power and
call your local service representative.

CAUTION

Do not touch the pumps while they are moving.

CAUTION

Ensure that all fluidic tubes are secured and properly connected or
sealed at both ends before, during and after operation.

CAUTION

Waste tubes and containers must be secured and sealed to
prevent accidental spillage.

2 Safety instructions
2.1 Safety precautions
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CAUTION

Make sure that the waste container has sufficient space for
maximum waste volume when the equipment is left unattended.

Maintenance

WARNING

All service and repairs, with the exception of operations explicitly
described in the user documentation, must be carried out by
personnel authorized by Cytiva. Do not open any covers or replace
any parts unless specifically stated in the user documentation.

WARNING
The Biacore S200 system contains mains voltage of up to 240 V AC.
Disconnect mains cord before replacing fuses. Do not remove
instrument covers.

WARNING

For continued protection from fire hazard, replace only with same
type and rating of fuse.

WARNING

If the instrument may be contaminated with biohazards, decon-
taminate the instrument before performing maintenance on any
instrument parts. Contact your local service representative for
further information about decontamination procedures.

CAUTION

Always turn off the power before opening the sample compart-
ment.

2 Safety instructions
2.1 Safety precautions
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CAUTION

The sample compartment door swings upwards when released. Do
not lean over the instrument when you open the sample compart-
ment door.

Decommissioning

WARNING

Decontaminate the equipment before decommissioning to ensure
that hazardous residues are removed.

2 Safety instructions
2.1 Safety precautions
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2.2 Labels

Introduction
This section describes the system label and other safety or regulatory labels that are
attached to the product.

System label
The system label is located on the back of the equipment. The system label identifies
the equipment and shows electrical data, regulatory compliance, and warning
symbols.

Description of symbols on the system
label

The following symbols may be present on the system label.

Symbol/text Meaning

Warning! Read the user documentation before using the system.
Do not open any covers or replace parts unless specifically stated
in the user documentation.

Code no Instrument assembly number

Serial no Instrument serial number

Mfg. Year Year (YYYY) and month (MM) of manufacture

Voltage

Frequency

Max Power

Electrical requirements:

• Mains voltage (VAC )

• Frequency (Hz)

• Maximum power (VA)

2 Safety instructions
2.2 Labels
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2.3 Emergency procedures

Introduction
This section describes how to shut down the Biacore S200 system in an emergency
situation, and the procedure for restarting the Biacore S200 system.

The section also describes the result in the event of power failure.

NOTICE

Do not use the acute emergency stop procedure unless there is a
risk of injury, damage or loss of valuable material. All operations
including buffer flow and data collection are stopped immediately.

To stop a run under controlled conditions before it is complete, choose Run →Stop
Run Sensorgram from the menu bar in Biacore S200 Control Software. This will stop
both the run and the data collection at the end of the current cycle. A dialog is
displayed while the current cycle is finished.

Emergency shutdown

In an emergency situation, follow the steps below to stop the run.

Step Action

1 Press Ctrl-Break (Ctrl-Pause) on the keyboard to stop the run and the data
collection immediately.

2 In the dialog box that appears, click Yes if you want to wash the system with
running buffer. You should do this if possible. The wash operation takes
about 3 minutes.

NOTICE

Do not leave the system in an emergency stop condition. Always
follow the restart procedure if possible, to restore the instrument
to normal condition.

Power failure
The following table describes the consequences of a power failure.

2 Safety instructions
2.3 Emergency procedures
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Power failure
to...

will result in...

Biacore S200
instrument

• The run is interrupted immediately.

• Data collected up to and including the last cycle
completed before the power failure is saved in the result
file.

Computer • The computer shuts down immediately.

• Instrument operation continues for a short time (until the
internal data buffer is full) and then stops.

• Data collected up to and including the last cycle
completed before the power failure is saved in the result
file, but there is a risk that the result file may be corrupt and
cannot be read.

Restart procedure

Follow the steps below to restart the system after an emergency shutdown.

Step Action

1 Turn on mains power if it is switched off and check that the instrument starts
normally.

2 If you need to clean the liquid handling system, eject the sensor chip and
insert a maintenance chip. See Cleaning and disinfecting the flow system, on
page 63 for further instructions.

2 Safety instructions
2.3 Emergency procedures
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3 System description

About this chapter
This chapter gives an overview of the Biacore S200 system, and a brief description of its
function.

In this chapter

Section See page

3.1 Biacore S200 instrument components 20

3.2 Indicators and switches 27

3.3 Sample and reagent racks 29

3.4 Sensor chip and flow system 31

3.5 Temperature control 33

3.6 Control system 34
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3.1 Biacore S200 instrument components

Overview
The Biacore S200 instrument is a processing unit with liquid handling, sample handling
and detection system, controlled from a PC running Biacore S200 Control Software.

The main parts of the instrument are illustrated below.

1

4

3

2

5

6

7

8

9

Part Function

1 Sample compartment door

2 Left pump compartment door

3 Sample compartment inspection window1

4 Rack tray port

5 Buffer tray

6 Status lamps

7 Sensor chip port

8 Right pump compartment door

9 Waste and water tray

1 Condensation may appear on the window during a temperature change. This is normal, and the
condensation should evaporate when the temperature has stabilized.

3 System description
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Bottle trays
The buffer tray on the left of the instrument holds up to four bottles for running buffer.
Up to four different buffers can be used.

The waste and water tray on the right of the instrument holds one 2-liter bottle for
waste solutions, and one 500 mL bottle for distilled water. Bottles with caps are
provided with the system.

The bottle trays are designed to hold standard bottles threaded for screw caps. One 1-
liter bottle and three 250 mL bottles with gaskets are provided with the system.

WARNING

Liquids in the buffer bottles or tubing may be toxic or flammable or
may cause chemical burns or irritation to skin and eyes. Take
appropriate precautions in the event of bottle breakage, accidental
spillage and insecure fitting of tubings to bottles.

CAUTION

Accidental breakage of buffer or water bottles may cause flooding
of the bottle tray, and liquid may enter the instrument enclosure. If
this happens, disconnect the instrument from the mains power and
call your local service representative.

Left pump compartment
The left pump compartment houses a buffer selector valve, two syringe pumps, and a
buffer degasser. To open the pump compartment, press on the inner edge of the door.

The illustration below shows the left pump compartment.

3 System description
3.1  Biacore S200 instrument components
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1

2

3

4

5

Part Function

1 Holder for unused buffer tubes

2 Buffer degasser

3 Syringe pump

4 Buffer selector valve

5 Buffer tray

 

Buffer tubing and selector valve

The buffer tubes, marked A, B, C, and D, are connected to the inputs of a buffer selector
valve, which determines which of the buffers is used during a run. Buffer selection is
controlled from the software. Buffer A is selected by default.

Attach unused buffer tubes to the tubing holder inside the pump compartment door.

 

Buffer degasser

The gas content of the running buffer is reduced to a low level by a vacuum degasser.
This eliminates the need to degas running buffer before use.

The vacuum pump of the degasser operates automatically as soon as the flow system
is started.

3 System description
3.1  Biacore S200 instrument components

22  Biacore S200 Operating Instructions 29143106 AD



NOTICE

The buffer tubing should always be connected via the buffer
degasser. Do not disconnect tubes from the degasser even if you
use degassed buffer.

Right pump compartment
The right pump compartment houses a peristaltic pump for supply of buffer and water
to the liquid supply block. To open the pump compartment, press on the inner edge of
the door.

CAUTION

The peristaltic pump may operate at any time during a run or
standby. Keep your hands clear of the pump if you open the right
pump compartment door during operation.

CAUTION

Waste tubes and containers shall be secured and sealed to prevent
accidental spillage.

The illustration below shows the right pump compartment.

1

2

3 System description
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Part Function

1 Peristaltic pump

2 Waste and water tray

The waste tubes are fitted on the waste bottle cap. Before starting a run, ensure that
the tube fittings are tightened and that the waste bottle is empty.

WARNING

Waste liquids may contain hazardous or flammable substances.
Take appropriate precautions to avoid spillage of hazardous waste.

NOTICE

The waste bottle and the cap must be of the same type and size as
the ones delivered with the system to avoid pressure disturbances
in the liquid handling system.

Sample compartment
The temperature-controlled sample compartment holds the autosampler and the
sample injection unit. The rack tray port on the front of the instrument is controlled
from the software.

Illumination of the sample compartment can be switched on and off from the software.

Autosampler
Samples and reagents are held in a microplate and/or rack in the autosampler and are
dispensed from there through the injection needle.

The illustration below shows the autosampler.

3 System description
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1

2

3

5

4

6

Part Function

1 Sample microplate

2 Injection needle

3 Liquid supply block

4 Reagent rack

5 Rack tray

6 Rack tray carriage

The liquid supply block on the autosampler is used for washing the needle and
emptying waste solutions. The peristaltic pump maintains a continuous flow of running
buffer and water to the liquid supply block throughout a run, ensuring fresh liquids at all
times.

The illustration below shows the liquid supply block on the autosampler.

3 System description
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3

2
1

Part Function

1 Waste outlet

2 Distilled water

3 Running buffer

Sensor chip port
The sensor chip port is protected by a cover which is controlled through software
commands and cannot be opened by hand. See Insert the sensor chip, on page 45 for
further details.

3 System description
3.1  Biacore S200 instrument components
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3.2 Indicators and switches

Status indicators
The status indicators on the front panel are described below.

Indicator Function

ready (green) Lit when power is on

system (red) Lit for a few seconds after the power is switched on. If the
indicator lights in other circumstances, turn off the
instrument and call your Cytiva service representative.

temperature (yellow) Lit when the temperature at the flow cells is stable at the
preset temperature. Flashes when the temperature is not
stable.

sensor chip (green) Lit when a sensor chip is docked and ready. Flashing when
a chip is inserted but not docked.

run (green) Lit when a run is in progress.

Mains power switch
The mains power connector and switch is located on the mains input panel, at the rear
right of the instrument.

The illustration below shows the location of the mains power connector and switch.

1

2

3

3 System description
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Part Function

1 Power on/off switch

2 Fuse holder

3 Power connector

Note: For warning texts, see Section 6.6 Replacing the mains fuses, on page 74.

3 System description
3.2 Indicators and switches
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3.3 Sample and reagent racks

Sample microplate
Biacore S200 uses standard 96-well and 384-well microplates that are mounted on the
rack tray. The microplate is held in position by a spring-loaded catch.

Biacore S200 is designed to accommodate both shallow and deep-well microplates
conforming to the Society of Biomolecular Screening (SBS) standard. However,
compatibility can only be guaranteed for microplates supplied or approved by Cytiva.
For information about compatibility with other microplates, contact your local Cytiva
representative.

The microplate should be covered with adhesive foil to prevent sample evaporation.

NOTICE

Use only foil supplied by Cytiva. The adhesive substance on the foil
is only present between wells. Align the foil with the microplate
when attaching it to avoid clogging the needle with adhesive.

Reagent rack
The reagent rack holds reagents and other solutions. The rack slides into the holder on
the rack tray and clicks into position. When changing racks, make sure that the rack is
correctly mounted and that it is pushed firmly into position. (If you attempt to mount
the rack in the wrong orientation, it will not click into position and you will not be able to
insert the rack tray into the instrument.)

3 System description
3.3 Sample and reagent racks
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Combined sample and reagent rack
A combined sample and reagent rack is available. The sample and reagent rack is
inserted into the sample compartment in place of the rack tray.

NOTICE

Always use vials with caps supplied by Cytiva. It is important that
the injection needle can penetrate the vial caps properly.

3 System description
3.3 Sample and reagent racks

30  Biacore S200 Operating Instructions 29143106 AD



3.4 Sensor chip and flow system

Overview
The liquid handling system comprises two syringe pumps, one peristaltic pump, the IFC
(Integrated µ-Fluidic Cartridge), the autosampler with injection needle, and the liquid
supply block.

The syringe pumps are used for precision delivery of samples, reagents and running
buffer to the sensor chip surface via the IFC. The peristaltic pump supplies buffer and
water to the liquid supply block. It also pumps waste solution from the liquid supply
block to the waste bottle.

The illustration below shows a simplified diagram of the liquid system showing delivery
of samples and running buffer to the IFC.

1

2

3

4

5

6

Part Function

1 Buffer bottle

2 Degasser

3 Syringe pumps

4 IFC

5 Needle

6 Waste bottle

3 System description
3.4 Sensor chip and flow system
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Sensor chip
The sensor chip is a gold-coated glass slide mounted on a supporting frame. The
sensor chip is normally enclosed in a protective cassette. Do not remove the sensor
chip from the cassette. The illustration below shows the sensor chip separate from the
cassette for illustration purposes.

Part Function

1 Frame

2 Gold-coated glass slide

3 Cassette

IFC (Integrated µ-Fluidic Cartridge)
The IFC consists of a series of micro channels and membrane valves encased in a
plastic housing, and serves to control delivery of liquid to the sensor chip surface.

Flow cells
Four separate flow cells are formed when the sensor chip is docked against the IFC.
Precision-cast channels in the surface of the IFC define the flow cells on the sensor chip
surface. The flow cells are optimized for use in pairs, Fc1+Fc2, Fc3+Fc4. The schematic
illustration below shows sample flow through Fc1 and Fc2.

3 System description
3.4 Sensor chip and flow system
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3.5 Temperature control

Introduction
SPR measurements are sensitive to changes in temperature. It is important that a
constant temperature is maintained at the sensor chip surface throughout the run.

Analysis temperature
The detection area housing the sensor chip is maintained at a precisely controlled
temperature (range 4°C to 45°C, not more than 20°C below ambient temperature).
Runs will not start automatically if the temperature at the sensor surface is not stable.
You can choose to ignore the condition or wait for the temperature to stabilize. The
Temperature indicator on the instrument front panel flashes if the analysis tempera-
ture is not stable.

Sample compartment temperature
The sample compartment is maintained at a temperature that may be set from 4°C to
45°C, not more than 15°C below ambient temperature.

The sample compartment temperature is set independently of the analysis tempera-
ture: injected samples have sufficient time in the needle and IFC to equilibrate to the
analysis temperature regardless of sample compartment temperature.

NOTICE

The system does not wait for the sample compartment tempera-
ture to stabilize. The Temperature indicator and screen display
show the analysis temperature, not the sample compartment
temperature.

Condensation may occasionally drip from the instrument during long runs at low
temperatures, particularly if ambient humidity is high. This is normal and does not
affect instrument operation.

3 System description
3.5 Temperature control
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3.6 Control system
Biacore S200 Control Software is a complete software for control and supervision of
Biacore S200.

Biacore S200 Evaluation Software is a stand-alone software for evaluation of results
obtained from Biacore S200. The software is normally installed on the same computer
as the Biacore S200 Control Software, although connection to the instrument is not
required for using Biacore S200 Evaluation Software.

3 System description
3.6 Control system

34  Biacore S200 Operating Instructions 29143106 AD



4 Installation

About this chapter
This chapter describes site requirements and preparations necessary to perform
before installation of the Biacore S200 system.

In addition, instructions are included for moving the Biacore S200 system within the
lab or to another building.

NOTICE
Biacore S200 is prepared and installed by Cytiva personnel.
Contact Cytiva if you require re-installation at a new site.

In this chapter

Section See page

4.1 Site requirements 36

4.2 Unpacking, assembly and transport 39

4.3 Connections 40
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4.1 Site requirements

WARNING

A fume hood or similar ventilation system shall be installed when
flammable or noxious substances are used.

WARNING

Explosion hazard. To avoid building up an explosive atmosphere
when using flammable liquids, make sure that the room ventilation
meets the local requirements.

Space requirements
The size of the instrument is indicated in the illustration below. At least 20 cm clear-
ance is required on all sides of the instrument to allow adequate air circulation. Space is
also required for the PC beside the instrument. The laboratory bench must be stable
and able to support the weight of the instrument.

4 Installation
4.1 Site requirements
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400 mm

680 mm

615 mm

600 mm

Electrical power requirements

WARNING

Protective ground. The product must always be connected to a
grounded power outlet.

WARNING

Use only mains cables supplied or approved by Cytiva.

4 Installation
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WARNING

Do not block the rear or side panels of the instrument. The power
switch must always be easy to access. The power cord must always
be easy to disconnect.

The instrument requires mains power outlets with protective earth as specified in the
table below.

Parameter Specification

Supply voltage 100 to 240 V~

Frequency 50/60 Hz

Maximum power 400 VA

Transient overvoltages Overvoltage category II

Environmental requirements
The following general requirements must be fulfilled:

• The room must have exhaust ventilation

• The instrument should not be exposed to direct sunlight

• Dust in the atmosphere should be kept to a minimum

The installation site must comply with the following specifications:

Parameter Specification

Allowed location Indoor use only

Ambient temperature, operation 18°C to 33°C

Max. relative humidity, operation 80% RH, non-condensing, up to 31°C.

Decreasing linearly to 50% RH at 40°C.

Ambient temperature, transportation/
storage

-25°C to 60°C

Altitude, operation Up to 2000 m

Pollution degree of the intended
environment

Pollution degree 2

Avoid placing the system adjacent to heaters or air conditioners.

Condensation may occur in the sample compartment at high ambient humidity. This is
normal and does not indicate any malfunction.
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4.2 Unpacking, assembly and transport

Unpacking
Biacore S200 will be unpacked by Cytiva personnel.

Check the equipment for any apparent damage before starting installation. Document
any damage carefully and contact your Cytiva representative.

Contact Cytiva if you need to re-pack Biacore S200 for storage or transport.

Assembly
Biacore S200 requires no special assembly other than that performed by Cytiva
personnel during installation.

Transport
To avoid damage, the optical unit in Biacore S200 must be secured before transport
over more than limited distances within the laboratory. Contact Cytiva for assistance.

CAUTION

Heavy object. Use proper lifting equipment, or use three or more
persons when moving the instrument. All lifting and moving must
be performed in accordance with local regulations.

CAUTION

Wear protective shoes with steel toecaps when moving the instru-
ment to protect against falling objects.

CAUTION

Make sure that hands or fingers are not trapped under the instru-
ment when the instrument is lifted or moved.
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4.3 Connections

NOTICE

Do not turn on the mains power switches before all connections
are made.

Connect the instrument to the
computer

Connect a serial communication cable between the COM1 (or IOIOIA) port of the PC,
and the PC connector on the rear panel of the instrument.

The SERVICE connector is for service purposes only.

NOTICE

Any computer used with the equipment shall comply with IEC
60950 and be installed and used according to the manufacturer’s
instructions.

The illustration below shows the location of the PC connector.

Connect to mains power

Follow the steps below to connect the instrument to a mains power source.
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Step Action

1 Connect the mains power cord delivered with the instrument, to the MAINS
INLET connector on the rear panel (see Mains power switch, on page 27).
Connect the other end to a mains outlet with protective earth.

2 Check that any mains voltage selectors on the PC and peripheral equipment
are set correctly.

3 Install the PC and peripheral equipment according to the respective instruc-
tion manuals.

WARNING

Do not block the rear or side panels of the instrument. The power
switch must always be easy to access. The power cord must always
be easy to disconnect.
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5 Operation

About this chapter
This chapter gives instructions on how to operate the product in a safe way.

In this chapter

Section See page

5.1 Starting the system 44

5.2 Preparing the instrument 45

5.3 Ejecting the rack tray 49

5.4 Adjusting the rack tray 51

5.5 Preparing samples and reagents 52

5.6 Changing reagent racks 54

5.7 Installing the rack tray 55

5.8 Starting and finishing a run 56

Safety precautions

WARNING
Always wear appropriate protective clothing and equipment during
operation and maintenance of the Biacore S200 system. Use
required safety equipment when handling hazardous substances.

WARNING

Do not use any accessories not supplied or recommended by
Cytiva.

5 Operation
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WARNING

Handle bottles carefully. Accidental breakage of buffer or water
bottles may cause flooding of the bottle tray, and liquid may come
into contact with electrical circuits, causing electric shock and/or
fire hazards.

WARNING

Liquids in the buffer bottles or tubing may be toxic or flammable or
may cause chemical burns or irritation to skin and eyes. Take
appropriate precautions in the event of bottle breakage, accidental
spillage and insecure fitting of tubings to bottles.

WARNING

Waste liquids may contain hazardous or flammable substances.
Take appropriate precautions to avoid spillage of hazardous waste.

CAUTION
Biacore S200 systems that are used with toxic or hazardous
substances shall be marked in accordance with local laws and
regulations.

CAUTION

Ensure that all fluidic tubes are secured and properly connected or
sealed at both ends before, during and after operation.

CAUTION

Waste tubes and containers shall be secured and sealed to prevent
accidental spillage.

CAUTION

Accidental breakage of glass bottles may leave sharp fragments
and splinters that can cause cuts and abrasions.
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5.1 Starting the system
Follow the steps below to start the system.

Step Action

1 Switch on the instrument. The status lamps on the front panel light in the
following sequence:

a. All the lamps light for a few seconds and then go out.

b. The green Ready lamp lights.

c. The yellow Temperature lamp flashes to indicate non-stabilized
temperature, and then is steadily lit when the temperature at the detec-
tion unit is stable. The time required for temperature stabilization
depends on the set temperature and ambient temperature. A tempera-
ture change of 5°C takes about 1 hour.

2 Switch on the printer and the PC.

3 Start Biacore S200 Control Software from the Windows Start menu.

4 The software establishes connection with the instrument, which takes about
30 seconds.
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5.2 Preparing the instrument

Prepare buffers

NOTICE

Always keep a high standard of hygiene in the solutions used.
Prepare fresh buffer before each run.

 

Using standard buffers

Standard buffers are available from Cytiva as stock solutions1. To prepare running
buffer, dilute the stock solution with distilled and filtered water. Available buffer solu-
tions include HEPES-buffered saline (HBS) and phosphate-buffered saline (PBS).

Phosphate buffer should not be used for interaction systems that require Ca2+ , since
calcium phosphate will precipitate at very low concentrations of Ca2+ .

 

Preparing your own buffers

All buffers used in Biacore S200, both as running buffer and for sample and reagent
preparation, should be filtered through a 0.22 µm filter.

Including a surfactant in the buffer can reduce non-specific adsorption of proteins to
the autosampler tube and the IFC channels. Surfactant P20 is available from Cytiva.
You may omit surfactant if your sample is detergent-sensitive. However, you may then
want to clean the flow system more frequently (see Cleaning and disinfecting the flow
system, on page 63 for more information).

Insert the sensor chip

Before Biacore S200 can be used, a sensor chip must be docked in the instrument.
Follow the steps below to dock a sensor chip.

Step Action

1 Click the Insert Chip button in the Tools workspace.

1 Buffers in 200 mL ready-to-use packs are not recommended for use with Biacore S200.
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Step Action

2 If a sensor chip is already docked, click the Eject Chip button in the Tools
workspace.

Click Eject Chip in the dialog box that appears. This will empty the flow cells
and eject the sensor chip.

3 The sensor chip port opens automatically when the chip is undocked.

4 If you are using a new chip, choose New Chip. Select the chip type from the
list, a Chip id and an optional lot number. The Chip id must be unique
among the chips that have been used on the instrument. Including the date
in the Chip id helps to ensure a unique value.

If you are re-using a chip that has previously been docked in the instrument,
choose Reuse chip and select the Chip id from the list. A chip that has been
previously used in a different instrument will not be included in the list and
must be inserted as a new chip.

5 Insert the sensor chip into the sensor chip port, with the arrows pointing into
the instrument.

6 Make sure that the sensor chip is fully inserted.

7 Close the sensor chip port cover. Press gently until it clicks into position.

8 If you need to open the sensor chip port cover at this stage (for example if
you have inserted the wrong chip), click Cancel. This will close the Insert
Chip dialog without docking the chip—you can then choose Insert Chip
again to open the port cover.

9 Click Dock chip. A standby flow of running buffer is started automatically
when the docking procedure is completed.
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Set up the liquid system

Follow the steps below to set up the liquid system.

NOTICE

Always use fresh water. Replace water before each run, or at least
every 48 hours. Do not run the system without water.

Step Action

1 Open the right pump compartment door and make sure that the clamp of
the peristaltic pump is properly fastened: the lever should be in a vertical
position.

2 Fill a suitable bottle with running buffer. Make sure that the bottle is clean
before use. Fit a cap with gasket on to the bottle and place it on the buffer
tray. Insert the tube marked A through the cap, into the running buffer
bottle.

3 If you plan to use more than one buffer, fill up to three additional bottles with
the required buffers. Fit caps with gaskets on to the bottles and place them
on the buffer tray. Insert the tubes marked B, C and D into the bottles.
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Step Action

4 Place unused buffer tubing in the holder inside the pump compartment
door.

5 Place a 2-liter bottle for waste solution on the waste and water tray. Fit the
cap carrying the waste tubes on to the bottle. Tighten the tube fittings by
hand. Do not use a smaller bottle for waste.

6 Fill a 500 mL bottle with distilled and filtered water. Fit a cap with gasket and
place it on the waste and water tray. Insert the water tube into the water
bottle.

7 Prime the flow system using Prime or MultiPrime from the Tools work-
space or using the option in the method, to ensure that the flow system is
equilibrated with fresh buffer.

Set the temperature
The temperature at the flow cell is shown in the status window of the Biacore S200
Control Software screen. The flow cell and/or sample compartment temperature can
be set either before starting a run or during the run setup procedure.

The system will wait until the temperature has stabilized at the set value before
starting the first run cycle. You can choose to ignore the temperature stabilization, but
this is not recommended as the signal will not be stable.
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5.3 Ejecting the rack tray

Introduction
The removable rack tray carries one microplate and one reagent rack, and is mounted
on the rack tray carriage in the sample compartment. The combined sample and
reagent rack is mounted directly on the rack tray carriage.

The rack tray (or the sample and reagent rack) can be ejected in three situations:

• before a run, when preparing samples and reagents,

• during setup of a run,

• during a manual run.

Ejecting the rack tray before a run

Follow the steps below to eject the rack tray before a run.

Step Action

1 Click the Eject Rack Tray button in the Tools workspace.

Result:

The rack tray is ejected and the following dialog is displayed:

2 Click OK.

Result:

The rack tray is moved into the instrument immediately.

The rack tray will be moved back into the instrument automatically after the
time shown in the dialog.

CAUTION

The rack tray automatically moves into the instrument a preset
time after it has been ejected. The time is set in Tools →Prefer-
ences. A timer in the dialog indicates when the rack tray will be
automatically moved into the instrument. Make sure no clothing or
body parts are trapped as the rack tray moves into the instrument.
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Removing the rack tray or sample and
reagent rack

To release the rack tray from the carriage, press the catch under the front edge of the
tray. Lift the tray slightly to take it out of the instrument.
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5.3 Ejecting the rack tray

50  Biacore S200 Operating Instructions 29143106 AD



5.4 Adjusting the rack tray
To accommodate some brands of microplates, it may be necessary to adjust the
retainers on the rack tray. Contact your Cytiva representative for more information.
Follow the steps below to adjust the microplate retainers.

Step Action

1 Loosen the screws underneath the rack tray and turn the retainers through
90° to accommodate the microplate.

2 Tighten the screws again after the adjustment.
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5.5 Preparing samples and reagents

In a microplate

Follow the steps below to prepare samples and reagents in a microplate.

Step Action

1 Dispense the samples and reagents into the microplate and/or vials. Check
that there are no air bubbles trapped at the bottom of the microplate wells. It
is particularly easy to trap air bubbles at the bottom of the wells in 384-well
microplates.

2 Cover the used sample wells in microplates with recommended adhesive
foil, available from Cytiva and cap any vials used. This prevents evaporation
from the samples during analysis.

3 Open the catch on the rack tray and slide the microplate onto the rack tray.
Place the microplate with well A1 facing towards the front of the rack tray.

1

2

3
A1

4 Close the catch and make sure that the microplate is properly seated on the
rack tray.

1

2
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In a reagent rack

Follow the steps below to prepare samples and reagents in a reagent rack (or sample
and reagent rack).

Step Action

1 Open the cover of the reagent rack, or the sample and reagent rack.

2 Dispense reagents to suitable vials. Cap the vials and place in the reagent
rack. Use only caps supplied for use in Biacore S200 by Cytiva.

3 Close the reagent rack cover and press until it snaps shut. Make sure that
the cover is completely closed.
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5.6 Changing reagent racks
Follow the steps below to change the reagent rack on the rack tray.

Step Action

1 Remove the rack from the rack tray by pushing firmly on the rack towards
the back of the tray.

2 Slide the new rack into the holder on the rack tray from the back of the tray.
Make sure that it is correctly oriented. The rack can only be fully inserted in
one orientation.

3 Push the rack until it snaps into position on the rack tray. Make sure that the
rack is properly in place.

Note:

If the rack is not correctly mounted, you will not be able to insert the rack tray
into the instrument.
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5.7 Installing the rack tray
Follow the steps below to install the rack tray or sample and reagent rack.

Step Action

1 If the rack tray port is not open when you are ready to install the rack tray,
eject the rack tray carriage.

2 Insert the rack tray. Press gently until the rack tray snaps into place.

3 The rack tray carriage automatically moves into the instrument a preset
time after it has been ejected. The time is set in Tools →Preferences. Click
OK in the Eject Rack Tray dialog to move the rack tray into the instrument
immediately.

CAUTION

The rack tray automatically moves into the instrument a
preset time after it has been ejected. The time is set in
Tools →Preferences. A timer in the dialog indicates
when the rack tray will be automatically moved into the
instrument. Make sure no clothing or body parts are
trapped as the rack tray moves into the instrument.

Note: The rack tray cannot be accessed during an automated run.
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5.8 Starting and finishing a run

Start a run
When docking of the sensor chip is ready, a standby flow of running buffer is started.

For details of how to start a run, refer to the Biacore S200 Software Handbook.

Standby mode
When a run is completed, the instrument is automatically placed in standby mode. A
continuous low flow of buffer (using buffer tube A) is maintained through the flow
system to prevent accumulation of buffer residues.

The default standby period is 7 days. Liquid consumption during standby is approxi-
mately 65 mL per 24 hours.

NOTICE

As a general recommendation use distilled and filtered water for
standby to minimize salt deposits. However, if an immobilized
sensor chip is docked and will be used for analysis later, buffer may
be used to protect the ligand on the sensor surface.

Wash buffer tubing
Use the maintenance tool Wash Buffer Tubing when you change from buffers
containing substances that tend to adsorb to the tubing, e.g. detergent or serum
albumin.

If you have used buffer tubes B, C or D and do not plan to use them in coming runs, run
the maintenance tool Empty Buffer Tubing to wash and empty the buffer tubing,
then place unused tubes in the holder in the left pump compartment.

Shutdown
If you want to shut down the instrument completely, see Section 6.5 Shutting down the
system, for instructions.
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6 Maintenance

About this chapter
This chapter summarizes user maintenance procedures. If more extensive service is
required, please contact your Cytiva service representative. Complete the appropriate
Health and Safety Declaration Form before contacting your local service representa-
tive or returning the system for maintenance or service.

Several maintenance operations are performed using software tools with on-screen
instructions in English. See Appendix A Software tool texts, on page 103 for these
instructions in your local language.

WARNING

All service and repairs, with the exception of operations explicitly
described in the user documentation, must be carried out by
personnel authorized by Cytiva. Do not open any covers or replace
any parts unless specifically stated in the user documentation.

WARNING
Always wear appropriate protective clothing and equipment during
operation and maintenance of the Biacore S200 system. Use
required safety equipment when handling hazardous substances.

CAUTION

Pinch risk. Take care that fingers are not trapped by moving parts
on the instrument.
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6.1 Maintenance preparations

Important
Make sure that the BIAmaintenance Kit type 2 is available before starting maintenance
procedures.

Regular maintenance of Biacore S200 is essential for reliable results. It is important to
keep the instrument free from contamination such as microbial growth and adsorbed
proteins in the liquid handling system.

Regular checks and maintenance should be done according to the schedules below.
You will be reminded of the need for Desorb and Desorb and Sanitize procedures via
a maintenance scheduler in the Control Software. Do not ignore maintenance
reminders.

Safety precautions

WARNING

If the instrument may be contaminated with biohazards, decon-
taminate the instrument before performing maintenance on any
instrument parts. Contact your local service representative for
further information about decontamination procedures.

WARNING

Concentrated BIAdisinfectant solution is corrosive. The solution
should be diluted shortly before use as described in the Instruc-
tions for Use provided with the product.

NOTICE

Some maintenance procedures will destroy the ligand on a
prepared sensor chip. Always use the separate Sensor Chip Main-
tenance that is included in the Maintenance Kit unless otherwise
stated.

NOTICE

Do not use BIAdesorb solution 1 at analysis temperatures below
20°C. BIAdesorb solution 1 precipitates at low temperatures.
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6.2 Maintenance summary

User maintenance operations
Regular checks and maintenance should be done according to the schedule below.

Interval Action

Daily/after each run Empty the waste bottle

Weekly Inspect tube fittings and pumps for possible leaks

Clean the flow system (Desorb)

Monthly Clean the instrument cover

Clean and disinfect the flow system (Desorb and Sanitize)

Inspect the needle and the liquid supply block

Inspect the sample compartment, look for signs of flooding

Run System Check

User service operations
Use the software tools listed in the table below for user service operations.

Tool Description

System Check Always run System Check before calling a Cytiva service
representative. The results of System Check may help in
diagnosing and solving your problems.

Software Problem
Report

Run this tool if you experience problems with Biacore S200
Software which do not have a readily apparent solution.

Flow System
Wash

This tool will flush the flow system with buffer at a high flow
rate to clear obstructions such as aggregated particles.

Superclean This tool can be used for extensive cleaning if the Desorb
and Sanitize procedure is not sufficient to clean the flow
system.

Required materials
Materials required for user maintenance and service operations are summarized
below.

 

BIAmaintenance Kit type 2
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The contents of the kit are listed below.

Solution/item Specification

BIAdesorb solution 1 0.5% (w/v) sodium dodecyl sulfate (SDS), two bottles
of 95 mL

BIAdesorb solution 2 50 mM glycine pH 9.5, two bottles of 95 mL

BIAtest solution 14.9% sucrose in HBS-N buffer with 3 mM EDTA, one
bottle of 65 mL

BIAdisinfectant solution
(conc.)

Sodium hypochlorite with 8% to 12% active chlorine,
three bottles of 10 mL

BIAnormalizing solution 70% (w/w) glycerol, one bottle of 90 mL

HBS-N buffer 10× One bottle of 50 mL

Sensor Chip Maintenance One sensor chip

All solutions except BIAdesorb solution 1 should be stored at +4°C to 8°C. BIAdesorb
solution 1 should be stored at room temperature.

 

Additional materials

In addition to the Maintenance Kit you will need the following materials:

• Distilled and filtered water

• 70% (v/v) ethanol

• Clean, lint-free wipes

• Series S Sensor Chip CM5

Preventive maintenance
To ensure correct performance of Biacore S200, preventive maintenance should be
done regularly by a qualified Cytiva service representative. During the maintenance
visit, worn parts are replaced and all vital modules of the system are tested.

The following components are always replaced:

• IFC

• Opto-interface

• Syringe pumps

• Peristaltic pump tubing
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6.3 User maintenance operations

Cleaning the instrument

WARNING

Liquids in the buffer bottles or tubing may be toxic or flammable or
may cause chemical burns or irritation to skin and eyes. Take
appropriate precautions in the event of bottle breakage, accidental
spillage and insecure fitting of tubings to bottles.

If necessary, clean the cover of the processing unit with a moist cloth. Use water or a
mild detergent.

The buffer tray and the waste and water tray can be removed for cleaning.

If necessary, clean the waste bottle cap as follows:

Step Action

1 Unscrew the cap from the waste bottle.

2 Loosen the tube fittings and remove the tubes from the cap.

3 Rinse the cap in deionized water.

4 Re-attach the tubes to the cap and tighten the fittings firmly.

Cleaning before planned
maintenance/service

To ensure the protection and safety of service personnel, all equipment and work areas
must be clean and free of any hazardous contaminants before a Service Engineer
starts maintenance work.

Please complete the checklist in the On Site Service Health and Safety Declaration
Form or the Health and Safety Declaration Form for Product Return or Servicing,
depending on whether the instrument is going to be serviced on site or returned for
service, respectively.

Health and safety declaration forms
Health and safety declaration forms are available for copying or printing in the Refer-
ence information chapter of this manual, or on digital media supplied with the user
documentation.

6 Maintenance
6.3 User maintenance operations

62  Biacore S200 Operating Instructions 29143106 AD



Cleaning and disinfecting the flow
system

The software supports maintenance tools for cleaning and disinfecting the flow
system, and for emptying and washing the buffer tubing.

The table below summarizes the tools provided.

Note: BIAdesorb solution 1 will precipitate at low temperature and should not be
used at analysis or sample compartment temperatures below 20°C. To run
Desorb below 20°C, replace BIAdesorb solution 1 with 0.5% lithium dodecyl
sulfate in water.

Tool Description Required materials

Desorb Cleans the flow system. Run once a
week, or more often if necessary.1

BIAdesorb solution 1

Biadesorb solution 2

Desorb and
sanitize

Cleans and disinfects the flow system.
Run at least once a week, or more often
if necessary.1

BIAdesorb solution 1

Biadesorb solution 2

BIAdisinfectant solu-
tion

HBS buffer

Empty
buffer
tubing

Washes and empties all buffer tubing.
Run whenever you intend to leave buffer
tubing unused for an extended period.

70% ethanol

BIAdesorb solution 2

Wash buffer
tubing

Washes one or all buffer tubes. Run
after using buffers containing
substances that tend to adsorb to the
tubing, e.g. detergent or serum albumin.

BIAdesorb solution 1

Biadesorb solution 2

1 Use Sensor Chip Maintenance or a used chip for the procedure. The solutions used may damage
the ligand on sensor chips used for assays.

Checking for leaks
Once a week, check that there are no liquid or salt deposits at the following positions
(see illustration below):

• Syringe pump: tube fittings, inside the pump barrel, at the plunger drive

• Buffer selector valve: tube fittings

• Degasser: tube fittings

• Peristaltic pump: tube fittings below the pump

If you find leaks at tube fittings, clean with water and tighten the connections.

If you find leaks in either of the syringe pumps, call your Cytiva service representative.
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1

2

3

4

5

6

7

8

Part Function

1 Degasser

2 Syringe pumps (see items 5 to 8)

3 Buffer selector valve

4 Peristaltic pump connections

5 Tubing connections

6 Plunger tip

7 Pump barrel

8 Plunger drive

Note: Condensate water may collect on the drip tray underneath the instrument
during long runs with cooling below ambient temperature. This is normal
and does not indicate leakage.

Normalizing the detector
This procedure adjusts the detector response to compensate for slight differences in
individual sensor chips. For best performance, run this procedure once for each new
chip. The procedure can either be run before immobilization or before the first run
using the immobilized chip. Normalization injects BIAnormalizing solution (70% glyc-
erol in water) over the chip surface.

The detector can be normalized either by using the maintenance tool Normalize
before starting a run or during the run setup procedure.

Required solutions: BIAnormalizing solution
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NOTICE

Run Normalize with the sensor chip that will be used for the run.
Do not use Sensor Chip Maintenance for this purpose.
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6.4 User service operations

Introduction
The software supports test and service tools for System Check, Software Problem
Report, Flow System Wash, and Superclean.

System Check
This procedure performs a comprehensive check of system performance, using a
standard sucrose solution (BIAtest solution), provided in the Biacore Maintenance Kit.

Use a new Sensor Chip CM5 for this procedure.

Required solutions

BIAtest solution

HBS-N buffer

 

System Check results

The table below provides some guidelines for interpreting the results of System
Check.

Test Likely cause of failure Explanation/Action

Reagent
pump

Water

Buffer

Air in injections 1 and 2 The clamp on the upper peristaltic
pump was not fastened.

Air in single injection Tubing squeezed or not fully
inserted into buffer or water.

Blank injection deviates from
baseline

Deposits in the liquid supply block.

Mixing

Mix 1

Mix 2

Difference

Leaks in syringe pump or
other parts of flow system

Call Cytiva service representative.

Flow cell leakage too large Call Cytiva service representative.

Refracto-
meter

Fc1

Fc2

Fc3

Fc4

Too low values A new chip was not used. May also
result in too large spread in base-
line level.

Too high or too low values Wrong buffer.
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Test Likely cause of failure Explanation/Action

Injections

Fc1

Fc2

Fc3

Fc4

Leaks in syringe pump or
other parts of flow system

Call Cytiva service representative.

Flow cell leakage too large Call Cytiva service representative.

Noise Drifting baseline A new chip was not used.

Temperature not stable. Call
Cytiva service representative.

Buffer
selector

Buffer A

Buffer B

Buffer C

Buffer D

Tubing in wrong bottles Check that the buffer tubes are
inserted in the correct bottles.

Buffer selector not working Call Cytiva service representative.

Leaking syringe pump Call Cytiva service representative.

Superclean
The Superclean procedure washes the flow system and denatures proteins to
increase their solubility. Warm water is used as running buffer to increase the solubility
of most biomolecules and salt. Required solutions differ according to whether the flow
system is contaminated with proteins or small molecules.

Run the maintenance tool Desorb and Sanitize followed by Superclean if you
suspect that the Desorb and Sanitize procedure is not sufficient to clean the flow
system. Total run time is about 1.5 hours.

Required solutions

For cleaning proteins For cleaning small molecules

deionized water at 50°C deionized water at 50°C

1% acetic acid 1% acetic acid

0.2 M sodium bicarbonate 0.2 M sodium bicarbonate

6 M guanidine-HCl 50%DMSO

10 mM HCl 10% DMSO

Use Sensor Chip Maintenance or a used chip for the procedure. The solutions used in
the Superclean procedure may damage the ligand on sensor chips used for assays.
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Open the sample compartment

CAUTION

Always turn off the power before opening the sample compart-
ment.

Follow the steps below if you need to access the needle and the liquid supply block for
cleaning.

Step Action

1 Choose Tools →Stop Standby if the instrument is in Standby mode.

2 Remove any microplate and reagent rack from the sample compartment.
Make sure that the rack tray is fully retracted and the sample compartment
is closed.

3 Turn off the mains power to the instrument.

4 Open the sample compartment door: use a flat head screwdriver to turn the
lock screw 1/8 turn counter-clockwise.
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CAUTION

The sample compartment door
swings upwards when released. Do
not lean over the instrument when
you open the sample compartment
door.

Clean the sample compartment

Follow the steps below to clean the sample compartment.

WARNING

The injection needle is sharp and may penetrate protective gloves.
Take particular care if hazardous agents have been used.

Step Action

1 Open the sample compartment as described in Open the sample compart-
ment, on page 68.

2 Remove the insulation plate at the back of the sample compartment (indi-
cated by the arrow in the illustration below).

3 Remove any spillage from the sample compartment with water or ethanol as
required.

4 Dry with a lint-free cloth.

5 If salt residues have accumulated on the needle or liquid supply block,
remove them with a damp cloth.
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Step Action

6 Replace the insulation plate at the back of the sample compartment.

7 Pull down the sample compartment door, and close the door by pressing it
down until it snaps into position.

8 Start the instrument and the software.

9 Run Prime to wash the needle and the liquid supply block.

Remove the sample compartment
box

If required, the sample compartment box can be removed for better access to the
sample compartment.

Follow the steps below to remove the sample compartment box.

Step Action

1 Open the sample compartment.

2 Pull out the tubing from the water bottle and remove the bottle.

3 Remove the cap from the waste bottle and remove the bottle.

4 Pull out the tubing from the buffer bottles and remove the bottles. Place the
tubing ends in the holder inside the left pump compartment.

5 Remove the buffer tray and the waste and water tray.
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Step Action

6 Use two 2.5 mm screwdrivers to press the two catches inside the sample
compartment box. Pull the box out from the instrument.

Replace the sample compartment
box

Follow the steps below to replace the sample compartment box.

Step Action

1 Push the sample compartment box along two guide rails into the instru-
ment. Press until it locks into position.

2 Replace the buffer tray and the waste and water tray.

3 Pull down the sample compartment door. Ensure that no tubing is in the way,
then close the door by pressing it onto the sample compartment box.
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6.5 Shutting down the system

Introduction
Biacore S200 should normally be left in standby mode when not in use. The instrument
maintains a low flow of liquid through the flow system. The maximum unattended
standby period is 7 days.

If the instrument is not to be used for a period of about two weeks or more, run the
Shutdown procedure to shut the instrument down completely.

Standby
The instrument enters standby mode automatically at the end of a run. To put the
instrument in standby mode manually, choose Tools →Standby.

NOTICE

As a general recommendation use distilled and filtered water for
standby to minimize salt deposits. However, if an immobilized
sensor chip is docked and will be used for analysis later, buffer may
be used to protect the ligand on the sensor surface.

Before leaving the instrument unattended in standby mode:

• Check that there is sufficient water or buffer for the standby period, and that the
buffer tube marked A is fully inserted into the water bottle. Liquid consumption
during standby is approximately 65 mL/24 h.

• Check that the waste bottle is emptied.

Shutdown

Follow the steps below to shut down the instrument completely.

Step Action

1 Run Desorb and Sanitize to clean the flow system.

2 Eject the rack tray carriage and remove the rack tray.

3 Prepare a bottle of distilled and filtered water, and a bottle of 70% ethanol.
Choose Shutdown from the Tools menu. Follow the instructions on the
screen.

The procedure flushes the flow system and then empties the IFC of liquid.
Total run time is about 20 minutes.
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Step Action

4 When instructed, open the right door and open the tube clamp of the peri-
staltic pump to relieve the pressure on the pump tubing.

To completely open the clamp, flip the lever to the right until it touches the
compartment wall.

5 Exit from Biacore S200 Control Software by selecting File →Exit then Exit
the software.

6 Open the sample compartment door and clean the needle and liquid supply
block if necessary.

7 Remove bottles, the waste cap assembly and the bottle trays. Seal the loose
tubing ends, for instance by wrapping them in plastic bags.

NOTICE

Before re-starting the system, make sure that the tube clamp is
properly closed.

Storage conditions
For storage, first perform the Shutdown procedure to empty and dry the flow system,
then clean the outside surfaces of the instrument using a soft cloth and water or a mild
detergent. Release the peristaltic pump clamp (see above) before storage.

Maintain normal conditions of temperature and humidity while the system is in
storage:

• Temperature: preferably room temperature, not below freezing

• Relative humidity: non-condensing, preferably low humidity

Contact Cytiva if you are uncertain of storage conditions.
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6.6 Replacing the mains fuses

WARNING

Disconnect power. Always disconnect power from the instru-
ment before replacing fuses.

WARNING

For continued protection from fire hazard, replace only with same
type and rating of fuse.

CAUTION

Do not replace the mains fuses if you suspect that there may be a
malfunction in the instrument. Contact your Cytiva service repre-
sentative for advice.

Follow the steps below to replace the mains fuses.

Step Action

1 Turn off the power to the Biacore S200 instrument.

2 Disconnect the mains cord from the mains power inlet.

3 Insert a small screwdriver under the tab on the fuse drawer cover.

4 Prise open the fuse drawer cover.
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Step Action

5 Replace both fuses.

See the instrument product label for fuse ratings.

6 Close the fuse drawer cover and reconnect the mains supply.
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7 Troubleshooting

About this chapter
This chapter gives a brief guide to troubleshooting procedures for problems with
Biacore S200.

In this chapter

Section See page

7.1 System-related problems 77

7.2 Assay-related problems 79
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7.1 System-related problems

Instrument hygiene
A fundamental requirement for trouble-free operation of Biacore S200 is that the
system is kept clean and is maintained regularly according to the following guidelines:

• Always use fresh buffer and distilled water. If you prepare your own buffers, filter
buffer and water through a 0.22 µm filter to remove particles. Ready-to-use buffers
from Cytiva are filtered.

• Follow the recommended maintenance procedures as described in the Mainte-
nance chapter of these Operating Instructions. Do not ignore maintenance
schedule reminders.

• If the system is used with particularly “sticky” molecules or complex mixtures such
as serum, clean the flow system thoroughly after each run.

• Leave the system in standby mode with freshly filtered distilled water or buffer when
not in use, or run the Shutdown procedure to empty the flow system. Do not leave
the instrument with liquid standing still in the flow system.

• Do not take the sensor chip out of its protective cassette. Dust or other particles on
the sensor chip surface can seriously interfere with detection.

Instrument considerations

• If the PC does not seem to communicate with the instrument, check that the
communication cable is properly connected.

• Make sure there is adequate ventilation around at the instrument site.

• Check the accessible tube fittings on the pumps, buffer selector valve and degasser
regularly for leaks.

• Make sure the clamp on the peristaltic pump is properly closed at the start of a run.
If the clamp is not closed, buffer and water will not be supplied properly to the liquid
supply block.

Buffer considerations

• Make sure that the correct buffer tubing is inserted into the buffer bottle(s). If you
are only using one buffer, you should use buffer tubing A. The syringe pumps will be
empty and the response will be out of range if no buffer is supplied to the flow cell.

• Check that there is sufficient buffer in the buffer bottle(s) and water in the water
bottle at the start of a run.

Sample considerations

• Make sure that you have sufficient sample and reagent in the vials and microplate.
The volumes specified in the software (see the Biacore S200 Software Handbook)
are minimum volumes with due consideration for dead volumes in different vials
and microplates. Larger volumes may be needed if you have problems with injection
of air in sample or reagent injections.
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• Use only recommended vials and microplates. Always cap vials and cover micro-
plates with foil, using the products supplied for this purpose by Cytiva.

• Use only recommended caps for vials and adhesive foil for microplates. Sample
evaporation from uncovered samples will both affect the sample concentration and
reduce the volume, possibly resulting in injection of air. Use of unsuitable adhesive
foil may block the autosampler needle with adhesive.

For further help
If you are experiencing instrument-related problems and are unable to identify and/or
correct them, run System Check, then contact your Cytiva service representative.
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7.2 Assay-related problems

Ligand considerations
Loss of ligand activity on the surface of the sensor chip is a common source of applica-
tion problems.

• If you cannot immobilize sufficient ligand with retained analyte-binding capacity, try
alternative immobilization methods or use a capturing approach. In some cases it
may be sufficient to perform immobilization at a milder pH, or to avoid exposure of
the ligand to immobilization buffer as far as possible. The immobilization wizard
supports dilution of ligand into immobilization buffer immediately before injection,
for ligands that do not withstand extended exposure to immobilization conditions.

• Make sure that the ligand withstands regeneration conditions without loss of
activity. If you cannot find suitable regeneration conditions, consider using a
capturing approach so that you use fresh ligand on the surface for each analysis
cycle.

• If you plan to store sensor chips with immobilized ligand for later use, perform
control experiments to establish that the ligand retains activity in the storage
conditions.

• Make sure you choose the correct flow path for a run. If you inject samples over a
flow cell where no ligand is immobilized, you will not see significant binding.

Sample considerations

• Make sure the samples do not precipitate at the concentrations and buffer condi-
tions used. Even micro-precipitation on the surface can seriously disturb the detec-
tion (or in the worst case block the flow system), and is generally seen as excessive
noise and irregularities in the sensorgrams.

• Where possible, samples should be prepared in running buffer or similar conditions.
Drastic changes in buffer composition between running buffer and sample can
introduce artefacts that may be difficult to interpret.

For further help
Several Biacore publications provide guidance on design and execution of experi-
ments. Contact Cytiva for more information.
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8 Reference information

About this chapter
This chapter lists the technical specifications of Biacore S200. The chapter also
includes a chemical resistance guide and Health and Safety Declaration forms for
service.

In this chapter

Section See page

8.1 Specifications 81

8.2 Maintenance tools 84

8.3 Chemical resistance 89

8.4 Recycling information 90

8.5 Regulatory information 91

8.6 Health and Safety Declaration Form 101
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8.1 Specifications
 

General

Parameter Value

Automation 48 h unattended operation

Limit of detection Typically below 1 RU (approximately 1 pg/mm2 for
proteins on Sensor Chip CM5)

Sample volume 10 to 425 µL (application dependent)

Sample/reagent capacity One 384 well or one 96 well microplate + 33 reagent
vials, or 78 vials for samples and reagents

Analysis time per sample Typically 2 to 15 min

Processing unit

Parameter Value

Dimensions w × d × h

(see also Space requirements, on page
36)

600 × 615 × 680 mm

Net weight 60 kg

Weight incl. packing 80 kg

Supply voltage Autorange 100 to 240 V~, protective
earthing

Maximum voltage fluctuation ± 10% from the nominal voltage

Frequency 50/60 Hz

Fuses 2 × T4.0AH

Maximum power consumption 400 VA

Analysis temperature 4°C to 45°C, max. 20°C below ambient
temperature

Ambient temperature range 18°C to 33°C

Ambient humidity 20% to 80% RH

Altitude Up to 2000 m
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Parameter Value

Transient overvoltages Overvoltage category II

Acoustic noise Not above 70 dB(A)

Flow cells
 

Parameter Value

Number of flow cells 4

Flow cell height Approximately 0.04 mm

Flow cell volume Approximately 0.06 µL

System controller and software

Parameter Value

PC operating system Microsoft Windows 7, Windows 8.

Interfacing Possibilities for import of sample data and export of results,
e.g. to LIMS.

Reagent racks
 

Parameter Value

Reagent rack, type 1

20 vials, diam. 11 mm (1.5 mL Eppendorf™-type)

Reagent rack, type 2

9 vials, diam. 16 mm (4.0 mL)

24 vials, diam. 7.5 mm (0.8 mL)
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Parameter Value

Sample and reagent rack

9 vials, diam. 16 mm (4.0 mL)

24 vials, diam. 11 mm (1.5 mL Eppendorf -type)

45 vials, diam. 7.5 mm (0.8 mL)

Microplates
 

Parameter Value

Microplate formats 96 or 384 shallow or deep-well plates, conforming to SBS
standard

Liquid containers
Buffer tray

Parameter Value

Running buffer 1 × 1 L and 3 × 250 mL, screw caps with gasket

Waste and water tray

Parameter Value

Waste 2 L (must be of the same type as the one delivered with
the system). Special screw cap with two tube fittings.

Water 500 mL, screw cap with gasket
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8.2 Maintenance tools

Desorb

English text Translation

This procedure removes adsorbed
material from the flow system.

This procedure removes adsorbed
material from the flow system.

Total run time is about 20 minutes. Total run time is about 20 minutes.

Do not run this procedure below 20°C. Do not run this procedure below 20°C.

NOTE: Use the Maintenance Chip or a
used chip for this procedure. The ligand
on the sensor chip may be damaged by
the solutions used.

NOTE: Use the Maintenance Chip or a
used chip for this procedure. The ligand
on the sensor chip may be damaged by
the solutions used.

Required solutions (from Maintenance
Kit):

BIAdesorb solution 1

BIAdesorb solution 2

Required solutions (from Maintenance
Kit):

BIAdesorb solution 1

BIAdesorb solution 2

Running Desorb procedure, please wait. Running Desorb procedure, please
wait.

The Desorb procedure is completed. The Desorb procedure is completed.

Desorb and Sanitize

English text Translation

This procedure removes adsorbed
material and disinfects the flow system.

This procedure removes adsorbed
material and disinfects the flow system.

Do not run this procedure below 20°C. Do not run this procedure below 20°C.

NOTE: Use the Maintenance Chip or a
used chip for this procedure. The ligand
on the sensor chip may be damaged by
the solutions used.

NOTE: Use the Maintenance Chip or a
used chip for this procedure. The ligand
on the sensor chip may be damaged by
the solutions used.

The procedure is divided into five steps. The procedure is divided into five steps.

Total run time is about one hour
followed by a recommended standby
time of 3-4 hours.

Total run time is about one hour
followed by a recommended standby
time of 3 to 4 hours.
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English text Translation

Do not abort this procedure after it is
started.

Do not abort this procedure after it is
started.

Required solutions (from Maintenance
Kit):

BIAdesorb solution 1: one volume of 25
mL and one volume of 15 mL

BIAdesorb solution 2: one volume of 25
mL and one volume of 15 mL

BIAdisinfectant solution: one volume of
50 mL and one volume of 30 mL

Required solutions (from Maintenance
Kit):

BIAdesorb solution 1, about 40 mL

BIAdesorb solution 2, about 40 mL

BIAdisinfectant solution, about 80 mL

Place 25 mL BIAdesorb Solution 1 on
the left hand tray and insert all four
pump inlet tubes.

Place 25 mL BIAdesorb solution 1 on the
left hand tray and insert all four pump
inlet tubes.

Place 15 mL BIAdesorb Solution 1 on
the right hand tray and insert the water
inlet tube.

Place 15 mL BIAdesorb solution 1 on the
right hand tray and insert the water
inlet tube.

Running Desorb and Sanitize procedure
step 1, please wait.

Running Desorb and Sanitize proce-
dure step 1, please wait.

Wipe the pump inlet tubes with a moist
tissue.

Wipe the pump inlet tubes with a moist
tissue.

Place 25 mL BIAdesorb Solution 2 on
the left hand tray and insert all four
pump inlet tubes.

Place 15 mL BIAdesorb Solution 2 on
the right hand tray and insert the water
inlet tube.

Place 25 mL BIAdesorb solution 2 on the
left hand tray and insert all four pump
inlet tubes.

Place 15 mL BIAdesorb solution 2 on the
right hand tray and insert the water
inlet tube.

Running Desorb and Sanitize procedure
step 2, please wait.

Running Desorb and Sanitize proce-
dure step 2, please wait.

Wipe the pump inlet tubes with a moist
tissue.

Wipe the pump inlet tubes with a moist
tissue.

Place 50 mL diluted BIAdisinfectant
Solution on the left hand tray and insert
all four pump inlet tubes.

Place 50 mL diluted BIAdisinfectant
solution on the left hand tray and insert
all four pump inlet tubes.

Place 30 mL diluted BIAdisinfectant
Solution on the right hand tray and
insert the water inlet tube.

Place 30 mL diluted BIAdisinfectant
solution on the right hand tray and
insert the water inlet tube.

Running Desorb and Sanitize procedure
step 3, please wait.

Running Desorb and Sanitize proce-
dure step 3, please wait.
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English text Translation

Wipe the pump inlet tubes with a moist
tissue.

Wipe the pump inlet tubes with a moist
tissue.

Place water on the left hand tray and
insert all four pump inlet tubes.

Place water on the left hand tray and
insert all four pump inlet tubes.

Place water on the right hand tray and
insert the water inlet tube.

Place water on the right hand tray and
insert the water inlet tube.

Running Desorb and Sanitize procedure
step 4, please wait.

Running Desorb and Sanitize proce-
dure step 4, please wait.

Place tube A in HEPES or TRIS buffer. Place tube A in HEPES or TRIS buffer.

Recommended concentration is 10-50
mmol/L.

Recommended concentration is 10 to
50 mmol/L.

Let tubes B, C and D hang in the air. Let tubes B, C and D hang in the air.

Running Desorb and Sanitize procedure
step 5, please wait.

Running Desorb and Sanitize proce-
dure step 5, please wait.

The Desorb and Sanitize procedure is
completed.

The Desorb and Sanitize procedure is
completed.

Allow the system to run in standby
mode for at least 3–4 hours before
performing a run.

Allow the system to run in standby
mode for at least 3 to 4 hours before
performing a run.

Empty Buffer Tubing

English text Translation

This procedure empties all four buffer
selector inlet tubes. The procedure is
divided into three steps.

This procedure empties all four buffer
selector inlet tubes. The procedure is
divided into three steps.

Total run time is about 20 minutes. Total run time is about 20 minutes.

Required solutions:

Deionized water

70% ethanol

Required solutions:

Deionized water

70% ethanol

Place a bottle containing deionized
water on the left hand plate and insert
the four buffer inlet tubes.

Place a bottle containing deionized
water on the left hand plate and insert
the four buffer inlet tubes.

This step flushes the buffer selector
with water.

This step flushes the buffer selector
with water.
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English text Translation

Running Empty Buffer Tubing proce-
dure step 1, please wait.

Running Empty Buffer Tubing proce-
dure step 1, please wait.

Place a bottle containing at least 10 mL
70% ethanol on the left hand plate and
insert the four buffer inlet tubes.

Place a bottle containing at least 10 mL
70% ethanol on the left hand plate and
insert the four buffer inlet tubes.

Running Empty Buffer Tubing proce-
dure step 2, please wait.

Running Empty Buffer Tubing proce-
dure step 2, please wait.

Remove the tubes from the ethanol
bottle and allow them to hang in the air.

Remove the tubes from the ethanol
bottle and allow them to hang in the air.

This step empties the buffer selector of
liquid.

This step empties the buffer selector of
liquid.

Running Empty Buffer Tubing proce-
dure step 3, please wait.

Running Empty Buffer Tubing proce-
dure step 3, please wait.

The Empty Buffer Tubing procedure is
completed.

The Empty Buffer Tubing procedure is
completed.

Normalize

English text Translation

Normalizes the signal in all flow cells. Normalizes the signal in all flow cells.

Total run time is about 9 minutes. Total run time is about 9 minutes.

NOTE: Do not normalize with the main-
tenance chip.

NOTE: Do not normalize with the Main-
tenance Chip.

This procedure normalizes the detector
signal. Total run time is about 9
minutes.

This procedure normalizes the detector
signal. Total run time is about 9
minutes.

Required solution (from Maintenance
Kit):

BIAnormalizing solution

Required solution (from Maintenance
Kit):

BIAnormalizing solution

Normalizing, please wait. Normalizing, please wait.

The Normalize procedure is completed. The Normalize procedure is
completed.
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Wash Buffer Tubing

English text Translation

This procedure cleans buffer tubing
from adsorbed material, e.g. after using
buffer with detergent.

This procedure cleans buffer tubing
from adsorbed material, e.g. after using
buffer with detergent.

Do not run this procedure below 20°C. Do not run this procedure below 20°C.

NOTE: Use the Maintenance Chip or a
used chip for this procedure. The ligand
on the sensor chip may be damaged by
the solutions used.

NOTE: Use the Maintenance Chip or a
used chip for this procedure. The ligand
on the sensor chip may be damaged by
the solutions used.

Select tubes to wash. Select tubes to wash.

This procedure removes adsorbed
material from the flow system. The
procedure is divided into three steps.
Total run time is about 30 minutes.

This procedure removes adsorbed
material from the flow system. The
procedure is divided into three steps.
Total run time is about 301 minutes.

Do not abort this procedure after it is
started.

Do not abort this procedure after it is
started.

Required solutions (from Maintenance
Kit):

BIAdesorb solution 1, about 20 mL

BIAdesorb solution 2, about 20 mL

Required solutions (from Maintenance
Kit):

BIAdesorb solution 1, about 201 mL

BIAdesorb solution 2, about 201 mL

Place 20 mL BIAdesorb Solution 1 on
the left hand tray and insert tube A.

Place 201 mL BIAdesorb solution 1 on
the left hand tray and insert tube A1.

Wipe the tube with a moist tissue. Wipe the tube with a moist tissue.

Place 20 mL BIAdesorb Solution 2 on
the left hand tray and insert the tube/all
four tubes.

Place 201 mL BIAdesorb solution 2 on
the left hand tray and insert the tube/all
four tubes1.

Place buffer or water on the left hand
tray and insert the tube/all four tubes.

Place buffer or water on the left hand
tray and insert the tube/all four tubes1.

NOTE: Remember to put tube A in buffer
or water (to be used during standby).

NOTE: Remember to put tube A in buffer
or water (to be used during standby).

Running Wash Buffer Tubing procedure
step 1/2/3, please wait.

Running Wash Buffer Tubing proce-
dure step 1/2/3, please wait.

The Wash Buffer Tubing procedure is
completed.

The Wash Buffer Tubing procedure is
completed.

1 Times, volumes and tube instructions vary acccording to the tubes selected for wash.
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8.3 Chemical resistance
This section gives some general guidelines concerning chemical resistance for
Biacore S200 components. Regarding exposure to solutions not covered by these
guidelines, contact your Cytiva representative for recommendations.

The flow system and sensor chip are the only parts of Biacore S200 that come into
contact with solutions. The guidelines in this section relate to tubing and connectors,
selector valves, connector block, IFC and sensor chip. In most analysis situations, the
ligand attached to the sensor surface limits the chemical resistance of the system as a
whole.

In general, the flow system components withstand long-term exposure to common
aqueous buffer solutions used in biochemical laboratories. The table below lists
compatibility with other common substances.

Concentrated organic solvents as well as long-term exposure to extremes of pH (<3
and >11) should be avoided. For solutions with short-term compatibility, do not use as
running buffer or for injections longer than 10 minutes. Solutions classed as long-term
compatible may be used as running buffer.

Solution Concentration Compatibility

Acetonitrile 50% Short term

Dimethyl formamide (DMF) 50% Short term

Dimethyl sulfoxide (DMSO) 50%

10%

Short term

Long term

Ethanol 70%

10%

Short term

Long term

Ethylene glycol 100% Short term

Formic acid 70% Short term

Formamide 40% Long term
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8.4 Recycling information

Introduction
This section contains information about the decommissioning of the product.

CAUTION

Always use appropriate personal protective equipment when
decommissioning the equipment.

Decontamination
The product must be decontaminated before decommissioning. All local regulations
must be followed with regard to scrapping of the equipment.

Disposal of the product
When taking the product out of service, the different materials must be separated and
recycled according to national and local environmental regulations.

Disposal of batteries
Waste batteries and accumulators must not be disposed of as unsorted municipal
waste and must be collected separately. Follow applicable local regulations for recy-
cling of batteries and accumulators.

Disposal of electrical components

Waste electrical and electronic equipment must not be disposed of as unsorted munic-
ipal waste and must be collected separately. Please contact an authorized representa-
tive of the manufacturer for information concerning the decommissioning of the
equipment.
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8.5 Regulatory information

Introduction
This section lists the regulations and standards that apply to the product.

In this section

Section See page

8.5.1 Contact information 92

8.5.2 European Union and European Economic Area 93

8.5.3 Eurasian Economic Union
Евразийский экономический союз

94

8.5.4 Regulations for North America 96

8.5.5 Regulatory statements 97

8.5.6 Declaration of Hazardous Substances (DoHS) 98

8.5.7 Other regulations and standards 100
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8.5.1 Contact information

Contact information for support
To find local contact information for support and sending troubleshooting reports, visit 
cytiva.com/contact.

Manufacturing information
The table below summarizes the required manufacturing information.

Requirement Information

Name and address of manufacturer Cytiva Sweden AB

Björkgatan 30

SE 751 84 Uppsala

Sweden

Telephone number of manufacturer + 46 771 400 600
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8.5.2 European Union and European Economic Area

Introduction
This section describes regulatory information for the European Union and European
Economic Area that applies to the equipment.

Conformity with EU Directives
See the EU Declaration of Conformity for the directives and regulations that apply for
the CE marking.

If not included with the product, a copy of the EU Declaration of Conformity is available
on request.

CE marking

The CE marking and the corresponding EU Declaration of Conformity is valid for the
instrument when it is:

• used according to the Operating Instructions or user manuals, and

• used in the same state as it was delivered, except for alterations described in the
Operating Instructions or user manuals.
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8.5.3 Eurasian Economic Union
Евразийский экономический союз

This section describes the information that applies to the product in the Eurasian
Economic Union (the Russian Federation, the Republic of Armenia, the Republic of
Belarus, the Republic of Kazakhstan, and the Kyrgyz Republic).

Introduction
This section provides information in accordance with the requirements of the Tech-
nical Regulations of the Customs Union and (or) the Eurasian Economic Union.

Введение
В данном разделе приведена информация согласно требованиям Технических
регламентов Таможенного союза и (или) Евразийского экономического союза.

Manufacturer and importer
information

The following table provides summary information about the manufacturer and
importer, in accordance with the requirements of the Technical Regulations of the
Customs Union and (or) the Eurasian Economic Union.

Requirement Information

Name, address and telephone
number of manufacturer

See Manufacturing information

Importer and/or company for
obtaining information about
importer

LLC Global Life Sciences Solutions Rus

Russian Federation, 123112

Presnenskaya nab., 10, fl. 12, pr. III, room 6

Telephone: + 7 495 739 6931

Fax nr: + 7 495 739 6932

E-mail: rucis@cytiva.com

Информация о производителе и
импортере

В следующей таблице приводится сводная информация о производителе и
импортере, согласно требованиям Технических регламентов Таможенного союза
и (или) Евразийского экономического союза.

Требование Информация

Наименование, адрес и номер
телефона производителя

См. Информацию об изготовлении
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Требование Информация

Импортер и/или лицо для
получения информации об
импортере

ООО "Глобал Лайф Сайэнсиз Солюшнз
Рус"

Российская Федерация, 123112

Пресненская наб., д. 10, эт. 12, пом. III,
ком. 6

Телефон: + 7 495 739 6931

Факс: + 7 495 739 6932

Адрес электронной почты: 
rucis@cytiva.com

Description of symbol on the system
label
Описание обозначения на этикетке
системы

This Eurasian compliance mark indicates that the product is
approved for use on the markets of the Member States of the
Customs Union of the Eurasian Economic Union

Данный знак о Евразийском соответствии указывает, что
изделие одобрено для использования на рынках
государств-членов Таможенного союза Евразийского
экономического союза

8 Reference information
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8.5.4 Regulations for North America

Introduction
This section describes the information that applies to the product in the USA and
Canada.

FCC compliance
This device complies with part 15 of the FCC Rules. Operation is subject to the following
two conditions: (1) This device may not cause harmful interference, and (2) this device
must accept any interference received, including interference that may cause unde-
sired operation.

Note: The user is cautioned that any changes or modifications not expressly
approved by Cytiva could void the user’s authority to operate the equip-
ment.

This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in
a commercial environment. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instruction
manual, may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful interference in which case the
user will be required to correct the interference at his own expense.
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8.5.5 Regulatory statements

Introduction
This section shows regulatory statements that apply to regional requirements.

EMC emission, CISPR 11: Group 1,
Class A statement

NOTICE

This equipment is not intended for use in residential environments
and may not provide adequate protection to radio reception in
such environments.

South Korea
Regulatory information to comply with the Korean technical regulations.

NOTICE

Class A equipment (equipment for business use).

This equipment has been evaluated for its suitability for use in a
business environment.

When used in a residential environment, there is a concern of radio
interference.

주의
A급 기기 (업무용 방송통신 기자재)

이 기기는 업무용환경에서 사용할 목적으로 적합성평가를 받
은 기기
로서 가정용 환경에서 사용하는 경우 전파간섭의 우려가 있습
니다.
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8.5.6 Declaration of Hazardous Substances (DoHS)
This section describes the information that applies to the product in China.

根据 SJ/T11364-2014《电子电气产品有害物质限制使用标识要求》特提供如下
有关污染控制方面的信息。
The following product pollution control information is provided according to SJ/
T11364-2014 Marking for Restriction of Hazardous Substances caused by electrical
and electronic products.

电子信息产品污染控制标志说明
Explanation of Pollution Control
Label

该标志表明本产品含有超过中国标准 GB/T 26572 《电子电气产品中限用物质的限量要
求 》中限量的有害物质。标志中的数字为本产品的环保使用期，表明本产品在正常使用
的条件下，有毒有害物质不会发生外泄或突变，用户使用本产品不会对环境造成严重污
染或对其人身、财产造成严重损害的期限。单位为年。
为保证所申明的环保使用期限，应按产品手册中所规定的环境条件和方法进行正常使
用，并严格遵守产品维修手册中规定的定期维修和保养要求。
产品中的消耗件和某些零部件可能有其单独的环保使用期限标志，并且其环保使用期限
有可能比整个产品本身的环保使用期限短。应到期按产品维修程序更换那些消耗件和零
部件，以保证所申明的整个产品的环保使用期限。
本产品在使用寿命结束时不可作为普通生活垃圾处理，应被单独收集妥善处理。
This symbol indicates the product contains hazardous materials in excess of the limits estab-
lished by the Chinese standard GB/T 26572 Requirements of concentration limits for certain
restricted substances in electrical and electronic products. The number in the symbol is the Envi-
ronment-friendly Use Period (EFUP), which indicates the period during which the hazardous
substances contained in electrical and electronic products will not leak or mutate under normal
operating conditions so that the use of such electrical and electronic products will not result in
any severe environmental pollution, any bodily injury or damage to any assets. The unit of the
period is “Year”.

In order to maintain the declared EFUP, the product shall be operated normally according to the
instructions and environmental conditions as defined in the product manual, and periodic main-
tenance schedules specified in Product Maintenance Procedures shall be followed strictly.

Consumables or certain parts may have their own label with an EFUP value less than the product.
Periodic replacement of those consumables or parts to maintain the declared EFUP shall be done
in accordance with the Product Maintenance Procedures.

This product must not be disposed of as unsorted municipal waste, and must be collected sepa-
rately and handled properly after decommissioning.
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有害物质的名称及含量
Name and Concentration of
Hazardous Substances

产品中有害物质的名称及含量
Table of Hazardous Substances’ Name and Concentration

部件名称
Component
name

有害物质
Hazardous substance

铅
(Pb)

汞
(Hg)

镉
(Cd)

六价铬
(Cr(VI))

多溴联苯
(PBB)

多溴二苯醚
(PBDE)

29136649 X 0 X 0 0 0

0: 表示该有害物质在该部件所有均质材料中的含量均在 GB/T 26572 规定的
限量要求以下。

X: 表示该有害物质至少在该部件的某一均质材料中的含量超出 GB/T 26572
规定的限量要求。

• 此表所列数据为发布时所能获得的最佳信息.

0: Indicates that this hazardous substance contained in all of the homogeneous
materials for this part is below the limit requirement in GB/T 26572.

X: Indicates that this hazardous substance contained in at least one of the
homogeneous materials used for this part is above the limit requirement in
GB/T 26572

• Data listed in the table represents best information available at the time of
publication.
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8.5.7 Other regulations and standards

Introduction
This section describes the standards that apply to the product.

Regulatory compliance of connected
equipment

Any equipment connected to Biacore S200 should meet the safety requirements of
IEC/EN/UL/CSA 61010-1, IEC/EN/UL/CSA 60950-1, or other relevant national safety
regulations and standards. The equipment should be installed and used according to
the manufacturer's instructions. Within EU, connected equipment must be CE marked.
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8.6 Health and Safety Declaration Form

On site service

 

 

On Site Service Health & 
Safety Declaration Form 

 
 

Service Ticket #: 
 

 

To make the mutual protection and safety of Cytiva service personnel and our customers, all equipment and work areas must be 
clean and free of any hazardous contaminants before a Service Engineer starts a repair. To avoid delays in the servicing of your 
equipment, complete this checklist and present it to the Service Engineer upon arrival. Equipment and/or work areas  
not sufficiently cleaned, accessible and safe for an engineer may lead to delays in servicing the equipment and could be subject to 
additional charges. 
 

 Yes  No 
Review the actions below and answer “Yes” or “No”.  
Provide explanation for any “No” answers in box below. 

 

 

 

 

 

 

Instrument has been cleaned of hazardous substances. 
Rinse tubing or piping, wipe down scanner surfaces, or otherwise make sure removal of any dangerous residue. 
Make sure the area around the instrument is clean. If radioactivity has been used, perform a wipe test or other 
suitable survey. 

 

 

 

 

Adequate space and clearance is provided to allow safe access for instrument service, repair or 
installation. In some cases this may require customer to move equipment from normal operating location 
prior to Cytiva arrival. 

 

 

 

 
Consumables, such as columns or gels, have been removed or isolated from the instrument and from 
any area that may impede access to the instrument . 

  All buffer / waste vessels are labeled.  
Excess containers have been removed from the area to provide access. 

Provide 
explanation 
for any “No” 
answers here: 

 

Equipment type / Product No:  Serial No:  

I hereby confirm that the equipment specified above has been cleaned to remove any hazardous substances and that the area 
has been made safe and accessible. 

Name:  Company or institution:    

Position or 
job title: 

 Date (YYYY/MM/DD):  

Signed: 
 

Cytiva and the Drop logo are trademarks of Global Life Sciences IP Holdco LLC or an affiliate. 

© 2020 Cytiva. 
All goods and services are sold subject to the terms and conditions of sale of the supplying company operating 
within the Cytiva business. A copy of those terms and conditions is available on request. Contact your local Cytiva 
representative for the most current information. 

For local office contact information, visit cytiva.com/contact. 
28980026 AD 04/2020 
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Product return or servicing

 

Health & Safety Declaration Form 
for Product Return or Servicing 

 
 

Return authorization 
number: 

 and/or 
Service Ticket/Request: 

 

To make sure the mutual protection and safety of Cytiva personnel, our customers, transportation personnel and our environment, 

all equipment must be clean and free of any hazardous contaminants before shipping to Cytiva. To avoid delays in the processing of 

your equipment, complete this checklist and include it with your return. 

1. Note that items will NOT be accepted for servicing or return without this form 

2. Equipment which is not sufficiently cleaned prior to return to Cytiva may lead to delays in servicing the equipment and 

could be subject to additional charges 

3. Visible contamination will be assumed hazardous and additional cleaning and decontamination charges will be applied 

 Yes   No Specify if the equipment has been in contact with any of the following: 

  Radioactivity (specify)  

  Infectious or hazardous biological substances (specify)  

  Other Hazardous Chemicals (specify)  

Equipment must be decontaminated prior to service / return. Provide a telephone number where Cytiva can contact 
you for additional information concerning the system / equipment. 

Telephone No:   

Liquid and/or gas in equipment is:  Water 

 Ethanol 

 None, empty 

 Argon, Helium, Nitrogen 

 Liquid Nitrogen 

Other, specify  

Equipment type / Product No:  Serial No:  

I hereby confirm that the equipment specified above has been cleaned to remove any hazardous substances and that 
the area has been made safe and accessible. 

Name: 
 Company or 

institution:   
 

Position or job title:  Date (YYYY/MM/DD)  

Signed:   

Cytiva and the Drop logo are trademarks of Global Life Sciences IP Holdco LLC or an affiliate. 

© 2020 Cytiva. 
All goods and services are sold subject to the terms and conditions of sale of the supplying company operating 
within the Cytiva business. A copy of those terms and conditions is available on request. Contact your local Cytiva 
representative for the most current information. 

For local office contact information, visit cytiva.com/contact. 
28980027 AD 04/2020 

To receive a return authorization number 
or service number, call local 
technical support or customer service.  
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Appendix A

Software tool texts

The on-screen instructions in the maintenance, test and service software tools are
given in English. Translations to other languages are provided in the local language
versions of these Operating Instructions.

In this chapter

Section See page

A.1 Maintenance tools 104

A.2 Test tools 109

A.3 Service tools 110

A Software tool texts
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A.1 Maintenance tools

Desorb

English text Translation

This procedure removes adsorbed
material from the flow system.

This procedure removes adsorbed
material from the flow system.

Total run time is about 20 minutes. Total run time is about 20 minutes.

Do not run this procedure below 20°C. Do not run this procedure below 20°C.

NOTE: Use the Maintenance Chip or a
used chip for this procedure. The ligand
on the sensor chip may be damaged by
the solutions used.

NOTE: Use the Maintenance Chip or a
used chip for this procedure. The ligand
on the sensor chip may be damaged by
the solutions used.

Required solutions (from Maintenance
Kit):

BIAdesorb solution 1

BIAdesorb solution 2

Required solutions (from Maintenance
Kit):

BIAdesorb solution 1

BIAdesorb solution 2

Running Desorb procedure, please wait. Running Desorb procedure, please
wait.

The Desorb procedure is completed. The Desorb procedure is completed.

Desorb and Sanitize

English text Translation

This procedure removes adsorbed
material and disinfects the flow system.

This procedure removes adsorbed
material and disinfects the flow system.

Do not run this procedure below 20°C. Do not run this procedure below 20°C.

NOTE: Use the Maintenance Chip or a
used chip for this procedure. The ligand
on the sensor chip may be damaged by
the solutions used.

NOTE: Use the Maintenance Chip or a
used chip for this procedure. The ligand
on the sensor chip may be damaged by
the solutions used.

The procedure is divided into five steps. The procedure is divided into five steps.

Total run time is about one hour
followed by a recommended standby
time of 3-4 hours.

Total run time is about one hour
followed by a recommended standby
time of 3 to 4 hours.

A Software tool texts
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English text Translation

Do not abort this procedure after it is
started.

Do not abort this procedure after it is
started.

Required solutions (from Maintenance
Kit):

BIAdesorb solution 1: one volume of 25
mL and one volume of 15 mL

BIAdesorb solution 2: one volume of 25
mL and one volume of 15 mL

BIAdisinfectant solution: one volume of
50 mL and one volume of 30 mL

Required solutions (from Maintenance
Kit):

BIAdesorb solution 1, about 40 mL

BIAdesorb solution 2, about 40 mL

BIAdisinfectant solution, about 80 mL

Place 25 mL BIAdesorb Solution 1 on
the left hand tray and insert all four
pump inlet tubes.

Place 25 mL BIAdesorb solution 1 on the
left hand tray and insert all four pump
inlet tubes.

Place 15 mL BIAdesorb Solution 1 on
the right hand tray and insert the water
inlet tube.

Place 15 mL BIAdesorb solution 1 on the
right hand tray and insert the water
inlet tube.

Running Desorb and Sanitize procedure
step 1, please wait.

Running Desorb and Sanitize proce-
dure step 1, please wait.

Wipe the pump inlet tubes with a moist
tissue.

Wipe the pump inlet tubes with a moist
tissue.

Place 25 mL BIAdesorb Solution 2 on
the left hand tray and insert all four
pump inlet tubes.

Place 15 mL BIAdesorb Solution 2 on
the right hand tray and insert the water
inlet tube.

Place 25 mL BIAdesorb solution 2 on the
left hand tray and insert all four pump
inlet tubes.

Place 15 mL BIAdesorb solution 2 on the
right hand tray and insert the water
inlet tube.

Running Desorb and Sanitize procedure
step 2, please wait.

Running Desorb and Sanitize proce-
dure step 2, please wait.

Wipe the pump inlet tubes with a moist
tissue.

Wipe the pump inlet tubes with a moist
tissue.

Place 50 mL diluted BIAdisinfectant
Solution on the left hand tray and insert
all four pump inlet tubes.

Place 50 mL diluted BIAdisinfectant
solution on the left hand tray and insert
all four pump inlet tubes.

Place 30 mL diluted BIAdisinfectant
Solution on the right hand tray and
insert the water inlet tube.

Place 30 mL diluted BIAdisinfectant
solution on the right hand tray and
insert the water inlet tube.

Running Desorb and Sanitize procedure
step 3, please wait.

Running Desorb and Sanitize proce-
dure step 3, please wait.
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English text Translation

Wipe the pump inlet tubes with a moist
tissue.

Wipe the pump inlet tubes with a moist
tissue.

Place water on the left hand tray and
insert all four pump inlet tubes.

Place water on the left hand tray and
insert all four pump inlet tubes.

Place water on the right hand tray and
insert the water inlet tube.

Place water on the right hand tray and
insert the water inlet tube.

Running Desorb and Sanitize procedure
step 4, please wait.

Running Desorb and Sanitize proce-
dure step 4, please wait.

Place tube A in HEPES or TRIS buffer. Place tube A in HEPES or TRIS buffer.

Recommended concentration is 10-50
mmol/L.

Recommended concentration is 10 to
50 mmol/L.

Let tubes B, C and D hang in the air. Let tubes B, C and D hang in the air.

Running Desorb and Sanitize procedure
step 5, please wait.

Running Desorb and Sanitize proce-
dure step 5, please wait.

The Desorb and Sanitize procedure is
completed.

The Desorb and Sanitize procedure is
completed.

Allow the system to run in standby
mode for at least 3–4 hours before
performing a run.

Allow the system to run in standby
mode for at least 3 to 4 hours before
performing a run.

Empty Buffer Tubing

English text Translation

This procedure empties all four buffer
selector inlet tubes. The procedure is
divided into three steps.

This procedure empties all four buffer
selector inlet tubes. The procedure is
divided into three steps.

Total run time is about 20 minutes. Total run time is about 20 minutes.

Required solutions:

Deionized water

70% ethanol

Required solutions:

Deionized water

70% ethanol

Place a bottle containing deionized
water on the left hand plate and insert
the four buffer inlet tubes.

Place a bottle containing deionized
water on the left hand plate and insert
the four buffer inlet tubes.

This step flushes the buffer selector
with water.

This step flushes the buffer selector
with water.
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English text Translation

Running Empty Buffer Tubing proce-
dure step 1, please wait.

Running Empty Buffer Tubing proce-
dure step 1, please wait.

Place a bottle containing at least 10 mL
70% ethanol on the left hand plate and
insert the four buffer inlet tubes.

Place a bottle containing at least 10 mL
70% ethanol on the left hand plate and
insert the four buffer inlet tubes.

Running Empty Buffer Tubing proce-
dure step 2, please wait.

Running Empty Buffer Tubing proce-
dure step 2, please wait.

Remove the tubes from the ethanol
bottle and allow them to hang in the air.

Remove the tubes from the ethanol
bottle and allow them to hang in the air.

This step empties the buffer selector of
liquid.

This step empties the buffer selector of
liquid.

Running Empty Buffer Tubing proce-
dure step 3, please wait.

Running Empty Buffer Tubing proce-
dure step 3, please wait.

The Empty Buffer Tubing procedure is
completed.

The Empty Buffer Tubing procedure is
completed.

Normalize

English text Translation

Normalizes the signal in all flow cells. Normalizes the signal in all flow cells.

Total run time is about 9 minutes. Total run time is about 9 minutes.

NOTE: Do not normalize with the main-
tenance chip.

NOTE: Do not normalize with the Main-
tenance Chip.

This procedure normalizes the detector
signal. Total run time is about 9
minutes.

This procedure normalizes the detector
signal. Total run time is about 9
minutes.

Required solution (from Maintenance
Kit):

BIAnormalizing solution

Required solution (from Maintenance
Kit):

BIAnormalizing solution

Normalizing, please wait. Normalizing, please wait.

The Normalize procedure is completed. The Normalize procedure is
completed.
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Wash Buffer Tubing

English text Translation

This procedure cleans buffer tubing
from adsorbed material, e.g. after using
buffer with detergent.

This procedure cleans buffer tubing
from adsorbed material, e.g. after using
buffer with detergent.

Do not run this procedure below 20°C. Do not run this procedure below 20°C.

NOTE: Use the Maintenance Chip or a
used chip for this procedure. The ligand
on the sensor chip may be damaged by
the solutions used.

NOTE: Use the Maintenance Chip or a
used chip for this procedure. The ligand
on the sensor chip may be damaged by
the solutions used.

Select tubes to wash. Select tubes to wash.

This procedure removes adsorbed
material from the flow system. The
procedure is divided into three steps.
Total run time is about 30 minutes.

This procedure removes adsorbed
material from the flow system. The
procedure is divided into three steps.
Total run time is about 301 minutes.

Do not abort this procedure after it is
started.

Do not abort this procedure after it is
started.

Required solutions (from Maintenance
Kit):

BIAdesorb solution 1, about 20 mL

BIAdesorb solution 2, about 20 mL

Required solutions (from Maintenance
Kit):

BIAdesorb solution 1, about 201 mL

BIAdesorb solution 2, about 201 mL

Place 20 mL BIAdesorb Solution 1 on
the left hand tray and insert tube A.

Place 201 mL BIAdesorb solution 1 on
the left hand tray and insert tube A1.

Wipe the tube with a moist tissue. Wipe the tube with a moist tissue.

Place 20 mL BIAdesorb Solution 2 on
the left hand tray and insert the tube/all
four tubes.

Place 201 mL BIAdesorb solution 2 on
the left hand tray and insert the tube/all
four tubes1.

Place buffer or water on the left hand
tray and insert the tube/all four tubes.

Place buffer or water on the left hand
tray and insert the tube/all four tubes1.

NOTE: Remember to put tube A in buffer
or water (to be used during standby).

NOTE: Remember to put tube A in buffer
or water (to be used during standby).

Running Wash Buffer Tubing procedure
step 1/2/3, please wait.

Running Wash Buffer Tubing proce-
dure step 1/2/3, please wait.

The Wash Buffer Tubing procedure is
completed.

The Wash Buffer Tubing procedure is
completed.

1 Times, volumes and tube instructions vary acccording to the tubes selected for wash.
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A.2 Test tools

System Check

English text Translation

This procedure checks for leakage and
tests pumps, injections, noise and
buffer selector.

This procedure checks for leakage and
tests pumps, injections, noise and
buffer selector.

Total run time is about 70 minutes. Total run time is about 70 minutes.

This procedure should be run at 25°C
with a new Sensor Chip CM5 and with
HBS-N as running buffer. Choose Close
if you need to change the sensor chip,
reset the temperature or change
running buffer.

This procedure should be run at 25°C
with a new Sensor Chip CM5 and with
HBS-N as running buffer. Choose Close
if you need to change the sensor chip,
reset the temperature or change
running buffer.

Select test(s) to run. Select test(s) to run.

Reagent pumps and blank injection.

Tests if the peristaltic pump is in order
and that a sample injection with buffer
from the reagent supply block is all
right.

Reagent pumps and blank injection.

Tests if the peristaltic pump is in order
and that a sample injection with buffer
from the reagent supply block is all
right.

Mix

Tests performance of the mixing.

Mix

Tests performance of the mixing.

Refractometer performance

Tests if the refractometer gives correct
responses.

Refractometer performance

Tests if the refractometer gives correct
responses.

Injections

Tests performance of the injections.

Injections

Tests performance of the injections.

Noise

Tests if noise is too high.

Noise

Tests if noise is too high.

If the buffer selector shall be tested
(test F), put tube B,C and D in water.

If the buffer selector shall be tested
(test F), put tube B,C and D in water.

If all inlet tubes are not intended to be
used after System Check, don't forget to
run Empty Buffer Tubing after the test.

If all inlet tubes are not intended to be
used after System Check, don't forget
to run Empty Buffer Tubing after the
test.
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A.3 Service tools

Software Problem Report
This tool does not involve any instrument operation.

Flow System Wash

English text Translation

This procedure washes the flow system
with buffer at a high flow rate to clear
any obstructions.

This procedure washes the flow system
with buffer at a high flow rate to clear
any obstructions.

Total run time is about 4 minutes. Total run time is about 4 minutes.

Running Flow System Wash, please
wait.

Running Flow System Wash, please
wait.

The Flow System Wash procedure is
completed.

The Flow System Wash procedure is
completed.

Superclean

English text Translation

This procedure is for extensive cleaning
of the liquid handling system. For best
result run Desorb prior to Superclean.

This procedure is for extensive cleaning
of the liquid handling system. For best
result run Desorb prior to Superclean.

Total run time is about 80 minutes. Total run time is about 80 minutes.

NOTE: Use the Maintenance Chip for
this procedure. The ligand on the sensor
chip may be damaged by the solutions
used.

NOTE: Use the Maintenance Chip for
this procedure. The ligand on the sensor
chip may be damaged by the solutions
used.

This procedure cleans the flow system.
Total run time is about 80 minutes.

This procedure cleans the flow system.
Total run time is about 80 minutes.

Put tube A in filtered deionized warm
water (40-50°C).

Put tube A in filtered deionized warm
water (40°C to 50°C).

A Software tool texts
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English text Translation

Required solutions:

1% acetic acid

0.2 M sodium bicarbonate

6 M guanidine-HCl (or 50% DMSO)

10 mM HCl (or 10% DMSO)

If small molecule assays are run,
exchange the last two wash solutions
for DMSO solutions.

Required solutions: 1% acetic acid 0.2 M
sodium bicarbonate 6 M guanidine-HCl
(or 50% DMSO) 10 mM HCl (or 10%
DMSO) If small molecule assays are run,
exchange the last two wash solutions
for DMSO solutions.

Running Superclean procedure, please
wait.

Running Superclean procedure, please
wait.

The Superclean procedure is
completed.

The Superclean procedure is
completed.

A Software tool texts
A.3 Service tools
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Appendix B

Technical description

About this appendix
This appendix gives a brief description of technical aspects of Biacore S200.

In this chapter

Section See page

B.1 Detection principle 113

B.2 Buffer and sample handling 115

B Technical description
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B.1 Detection principle

Surface plasmon resonance
Biacore S200 exploits the phenomenon of surface plasmon resonance (SPR) to detect
and measure analyte. SPR is a phenomenon that occurs in thin conducting films at an
interface between media of different refractive index.

Under conditions of total internal reflection, the light leaks an electric field intensity
called an evanescent wave field across the interface into the medium of lower refrac-
tive index, without actually losing net energy.

The amplitude of the evanescent field wave decreases exponentially with distance
from the surface, and the effective penetration depth is about half the wavelength of
the incident light.

At a certain combination of angle of incidence and energy (wavelength), the incident
light excites plasmons (electron charge density waves) in the gold film. As a result, a
characteristic absorption of energy via the evanescent wave field occurs and SPR is
seen as a drop in the intensity of the reflected light (illustrated below).

1 2

3

4

5

6
3

Item Explanation

1 Incident light

2 Reflected light

3 SPR angle

4 Sensor chip

5 Flow cell

6 Plot of reflected light intensity against angle of reflection

Because the evanescent wave field penetrates the solution, conditions for this reso-
nance effect are sensitive to the refractive index of the solution within the effective
penetration depth of the evanescent field. Changes in solute concentration at the
surface of the sensor chip cause changes in the refractive index of the solution, which is
measured as a changes in the SPR angle.

B Technical description
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Note: The reduced intensity of reflected light is not caused by light absorption in
the sample in the conventional (transmission spectroscopy) sense. The light
used to generate the signal is totally internally reflected inside the optical
unit, and it is the evanescent wave that penetrates the sample. Conse-
quently, measurements can be made on turbid or even opaque solutions,
without interference from conventional light absorption or scattering by the
sample.

What SPR measures
In the configuration used in Biacore S200, the SPR response is a measure of the refrac-
tive index of the solution within the penetration distance of the evanescent field wave.
This distance (about 300 nm) is small in relation to the height of the flow cell, so that
SPR effectively measures the refractive index at the surface of the sensor chip.

The refractive index of the solution varies with the solute content. When the detecting
molecule is attached to the sensor chip or when analyte binds to the detecting mole-
cule, the solute concentration at the sensor chip surface increases, leading to a change
in the SPR signal.

The response measured in Biacore S200 is related to the mass of analyte bound and is
largely independent of the nature of the analyte. Refractive index contributions for
different solutes are additive, so that the amount of detecting molecule attached and
the amount of analyte bound can both be measured with the same detection principle.

B Technical description
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B.2 Buffer and sample handling

Flow system
Two high performance syringe pumps and one peristaltic pump handle the distribution
of buffer and water to the IFC and the liquid supply block.

One syringe pump maintains a low flow of buffer through the IFC. The second syringe
pump is used for aspiration of samples and reagents, and precision delivery to the
sensor chip surface via the IFC. The system switches automatically between these
pumps as required.

The peristaltic pump continuously supplies buffer and water to the liquid supply block.
The buffer supplied to the liquid supply block is used for washing the injection needle.
The buffer flow also helps keeping the liquid supply block clear of precipitated buffer.

Water supplied to the liquid supply block is used for rinsing the needle and the liquid
supply block itself.

Effluent from the IFC and the liquid supply block is conveyed to the waste bottle.

The flow system is illustrated schematically below.
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A DCB

1

2

3

4

5

6

7

8

9

10 11 12

Part Function

1 Buffer selector valve

2 Buffer degasser

3 Syringe pumps

4 IFC

5 Injection needle

6 Sample microplate

7 To waste

8 Liquid supply block

9 Peristaltic pump

10 Buffer bottles
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Part Function

11 Waste bottle

12 Water bottle

Buffer degasser
The degasser consists of independent vacuum chambers, each containing membrane
tubing, which is permeable to small gas molecules.

Each of the two buffer tubes from the selector valve is connected to a separate vacuum
chamber. A vacuum pump maintains a low pressure in the vacuum chambers, thereby
drawing gas molecules through the membrane tubing.

Valves in the degasser switch pump input between the vacuum chambers and atmos-
phere. This keeps the pump clean and increases the service life of the degasser. An
active carbon filter provides added protection for the vacuum pump.

Cooling unit
A maintenance-free cooling unit based on Peltier elements is located behind the
sample compartment. Contact your Cytiva service representative if the sample
compartment warms up in spite of a low temperature setting.
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